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Important notices

Intended use

Warnings
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The measurement of oxygen uptake during sport or real life activities is of great interest
for the development of training programs and the study of their effects on elite athletes
or for assessing the efficacy of a rehabilitation therapy.

A common method for assessing the effects of endurance training is the monitoring of
various respiratory parameters during submaximal exercise.

One difficulty to achieve this goal during sport that cannot be simulated in the
laboratory is to use a reliable and valid portable system to measure VO, and VCO, in a
field setting.

Such a portable apparatus may also be useful to determine the energy cost of many sport
and real life activities.

K4 b? is an electrical medical device designed to perform pulmonary function tests. It is
to be used by physicians or by trained personnel on a physician responsibility.

Caution: Federal law restricts this device to sale by or on the order of a physician.

This equipment has been conceived with the aim of providing an auxiliary instrument
allowing:

e the formulation of lung pathology diagnosis;

e important studies concerning human physiology;

e the collection of important information in sport medicine.

No responsibility attaches COSMED Srl for any accident happened after a wrong use of
the device, such as:

e use by non qualified people;
e non respect of the device intended use;

e non respect of the hereunder reported precautions and instructions.

The device, the programme algorithms and the presentation of measured data have been
developed according to the specifications of ATS (American Thoracic Society) and
ERS (European Respiratory Society). Other international references have been followed
when these were not available. All bibliography references are reported in Appendix.

The present handbook has been developed with respect of the European Medical Device
Directive requirements which sort K4 b* within Class II a.

It is recommended to read carefully the following precautions before putting the device
into operation.

The precautions reported below are of fundamental importance to assure the safety of
all COSMED equipment users.

1. This user manual is to be considered as a part of the medical device and should
always be kept on hand.

2. Safety, measure accuracy and precision can be assured only:

¢ using the accessories described in the manual or given with the device. Actually
non recommended accessories can affect safety unfavourable. Before using non
recommended accessories it is necessary to get in touch with the manufacturer;

e ordinary equipment maintenance, inspections, disinfection and cleaning are
performed in the way and with the frequency described;

¢ any modification or fixing is carried out by qualified personnel;

e the environmental conditions and the electrical plants where the device operates
are in compliance with the specifications of the manual and the present regulations
concerning electrical plants. In particular grounding reliability and leakage current
suppression can only be assured when the device three — wire receptacle is
connected to a yellow - green return connected to earth ground. Attempting to
defeat the proper connection of the ground wire is dangerous for users and
equipment.




°

[

Before powering the system, check the power cables and the plugs. Damaged
electrical parts must be replaced immediately by authorised personnel.

Large gas cylinders, which may be given by the manufacturer or purchased by the
customer, should be secured with cylinder safety chains or safety stands.

When removing the protective cap, inspect the cylinder valve for damaged threads,
dirt, oil or grease. Remove any dust or dirt with a clean cloth. If oil or grease is
present on the valve of a cylinder which contains oxygen, do not attempt to use.
Such combustible substances in contact with oxygen are explosive.

Be certain that the materials of the pressure regulators are chemically compatible
with the intended gas service before installation. Inspect the regulator for the proper
connection and note the ranges of the pressure gauges. Also examine the physical
condition of the regulator including threads and fittings. Remove any dust or dirt
from the regulator or cylinder valve with a clean cloth. Do not install a regulator on
a cylinder valve containing oxygen if grease or oil is present on either. Such
substances in contact with oxygen are explosive.

Cleaning residue, particulates, and other contaminates (including pieces of torn or
broken components) in the breathing circuit pose a safety risk to the patient during
testing procedures. Aspiration of contaminates can potentially be life-threatening.
You must follow all the cleaning procedures in System Maintenance, and you must
thoroughly inspect the components after cleaning and before each patient test.

This device is not suitable for use in presence of flammable anaesthetics. It is not
an AP nor an APG device (according to the EN 60 601-1 definitions).

Keep the device away from heat and flame source, flammable or inflammable
liquids or gases and explosive atmospheres.

. In accordance with their intended use K4 b* is not to be handled together with other
medical devices unless it is clearly declared by the manufacturer itself.

. It is recommended to use a computer with electromagnetic compatibility CE
marking and with low radiation emission displays.

. It is necessary to make the PC, connected to the K4 b*, compliant with EN 60601-1
by means of an isolation transformer.

. Graphical symbols used in accordance to present specifications are described here
below:

Equipment type B (EN60601-1)
Danger: high temperature
OFF

ON

Protective earth ground

(! ®—0Op>

Alternating current
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Contraindication

The physical strain to execute the respiratory manoeuvre is contraindicated in case of
some symptoms or pathology. The following list is not complete and must be
considered as a piece of mere information.

Contraindications for the Spirometer tests

Absolute contraindications

For FVC, VC and MVYV tests:

e Post-operating state from thoracic surgery

For FVC tests:

e Severe instability of the airways (such as a destructive bronchial emphysema)
e Bronchial non-specific marked hypersensitivity

e Serious problems for the gas exchange (total or partial respiratory insufficiency)

Relative contraindications

For FVC tests:

e spontaneous post-pneumothorax state

e arterial-venous aneurysm

e strong arterial hypertension

e  pregnancy with complications at the 3™ month.
For MVV test:

e hyperventilation syndrome

Contraindications for Bronchial provocation tests

The bronchial provocation tests must be executed according to the doctor’s discretion.
There are not data that reveal specific contraindication for the bronchial provocation test
through inhalation.

The modern standard processes have been revealing secure in several clinical studies.
However it is recommendable to respect the following contraindications:

Absolute contraindications

e  Serious bronchial obstruction (FEV1 in adults)
e Recent myocardium infarct

e Recent vascular-cerebral accident

e Known arterial aneurysm

e Incapacity for understanding the provocation test procedures and its implications.

Relative contraindications
e Bronchial obstruction caused by the respiratory manoeuvre.

e  Moderate or serious bronchial obstruction. For ex. Predicted value FEV1 less than
1.51 in men and predicted value FEV1 in women less than 1.21.

e Recent infection in the superior air tracts
¢ During the asthmatic re-acuting

e Hypertension

e  Pregnancy

e A pharmacology treatment epilepsy

Contraindications for Exercise testing
Read carefully the exercise testing chapter.
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Environmental condition of use

COSMED units have been conceived for operating in medically utilised rooms without
potential explosion hazards.

The units should not be installed in vicinity of x-ray equipment, motors or transformers
with high installed power rating since electric or magnetic interferences may falsify the
result of measurements or make them impossible. Due to this the vicinity of power lines
is to be avoided as well.

Cosmed equipment are not AP not APG devices (according to EN 60601-1): they are
not suitable for use in presence of flammable anaesthetic mixtures with air, oxygen or
nitrogen protoxide.

If not otherwise stated in the shipping documents, Cosmed equipment have been
conceived for operating under normal environmental temperatures and conditions [IEC
601-1(1988)/EN 60 601-1 (1990)].

e  Temperature range 10°C (50°F) and 40°C (104°F).
e Relative humidity range 20% to 80%
e Atmospheric Pressure range 700 to 1060 mBar

e Avoid to use it in presence of noxious fumes or dusty environment and near heat
sources.

e Do not place near heat sources.
e Cardiopulmonary resuscitation emergency equipment accessible.
e Adequate floor space to assure access to the patient during exercise testing.

e Adequate ventilation in the room.
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Safety and conformity
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Safety

IEC 601-1 (1988) /EN 60 601-1 (1990);

Find reported below the complete classification of the device:
e (lass I type B device

e Protection against water penetration: IP00, ordinary equipment unprotected against
water penetration

e Non sterile device
e Device not suitable in the presence of flammable anaesthetics;

e Continuous functioning equipment;

EMC
The system meets the EMC Directive 89/336
EN 60601-1-2

EN 55011 Class B (emission), IEC 1000-4-2, IEC 1000-4-3, IEC 1000-4-4

Telemetry
I-ETS 300 220, CEPT T/R 01-04
pr ETS RES 0908 (CE type conformity)

Transmission frequency and output power can be changed upon request according to the
destination country requirements.

Quality Assurance
UNI ISO 9001 (Registration n° 387 Cermet)

Medical Device Directive (CE mark)
MDD 93/42/EEC (Notified Body 0476).
Class IIa




Here are the keynotes used to make the manual easier to read.

Typographic keynotes

These are the typographic keynotes used in the manual.

Style Description
Bold indicates a control or a key to be pressed.
“Italic” indicates a messages shown by the firmware.

Graphic keynotes
These are the graphic keynotes used in the manual.

Illustration Description
START L. .
shows the button to click in the software to activate the related feature.
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System overview

Portable Unit (PU)

It is fixed to the patient during the test by an anatomic
harness. The PU contains the O, and CO, analyzers, sampling
pump, UHF transmitter, barometric sensors and electronics. It
is powered by the rechargeable battery fixed to the back side
of the harness.

K4 b? is also provided with a small display, the PU shows in
real time the following parameters: VT, VE, VO,, VCO,, R,
HR, Rf Marker, battery charge level, temperature and
barometric pressure.

Besides data processing and presentation, the Portable Unit
has the following functions:

e Patient data input

e Environment data input (humidity)

e  Gas and turbine calibration (automatic)
e  Memory functions

e  Tests data management

e Data loading to a PC (via RS232)

Telemetry Data Transmission, Receiver Unit (RU)

(
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The RU consists of a small unit connected to a PC through the
RS 232 serial port. The transmission is achieved by a
miniaturized transmitter module located inside the Portable
Unit.

The CU allows the simultaneously charge of the 3 Ni-Cd
batteries and to supply the PU during the warm up time.




Flowmeter

Gas analysers

PC Software

The system uses a bi-directional digital turbine. It opposes a very low resistance to flow
(<0,7 cmH,O/1/s to 12 1I/s). The air passing through the helical conveyors, takes a spiral

motion which causes the rotation of the turbine rotor. The rolling blade interrupts the
infrared light beamed by the three diodes of the optoelectronic reader. Every
interruption represents 1/6 turn of the rotor, this allows to measure the number of turn in
the time.

The O, and CO, analysers are temperature-controlled and the internal pressure and
expired flow are monitored for an higher reliability if the measurements.

The K4 b? uses Nafion Permapure ® which is a semipermeable capillary tube capable of
removing the humidity in excess without altering the gas concentrations..

The analysers calibration is automatic and shows both graphically and numerically the
flow and concentration signals and the accuracy of the baseline/gain.

The PC software, running on Windows™, allows the user to manage data stored in the
Portable Unit or transmitted to PC. Here following a list of the main features available:

e  Test data management.
e Viewing data in table and graphic form

e Automatic and manual detection of anaerobic threshold (modified V-slope
method).

e  On-line data presentation during tests.
e Advanced data elaboration (filtering, smoothing, built in spread-sheet features).

e O, Kinetics (O, deficit, O, debt and time constant in both rising and falling edge of
a constant load exercise test).

¢  Flow-Volume loops during the test and overlapped on the rest FVC.

e Real time display of the O, and CO, waveforms during the test.

e  Control of any ergometer provided with a RS232 interface.

e Custom fittings (linear and exponential).

e Spirometry (FVC, VC, IVC, MVV).

e  File exporting in three different formats (Lotus 123™, Excel™, ASCII).

e  Automatic detection of the "Steady State".

¢ Adding parameters and predicted equations trough the "Formula Editor" tool-kit.
e DDE with Microsoft Excel.

e Customizing software environments (colours, printed parameters...).

e Help on line.
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Before starting

Before operating the K4 b* we strongly recommend to check the equipment and register
you as a customer.

Checking the packing contents
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Make sure that the package contains the items listed below. In case of missing or
damaged parts, please contact Cosmed technical assistance.

K4 b2 standard packaging

Code Qty Description

C00950-01-04
C00952-01-04
C01599-01-04
C00260-01-04
C01570-01-06
C00342-01-12
C02120-01-05
C02200-01-11
A 800900 001
C02210-01-08
C02125-01-10
C02135-01-10
C02145-01-10
A 661 200 001
A 661 200 002
A 182320 001
C01460-01-06
A 362 060 001
C01507-01-12
C00659-01-12
A 410110002
C02100-02-06
C00341-01-12
C01577-01-12
C01929-01-08
C01143-01-98
C01800-01-05
C01509-01-30
C01588-01-20
A 680 023 500
A 680 044 500
C01506-02-35
C01999-02-DC
C00067-02-94
C01508-02-91

K4 b Portable Unit (only non telemetric version)
K4 b* Portable Unit (only telemetric version)
K4 b* Receiver Unit (only telemetric version)
K4 b® Battery Charger Unit
Antenna

Antenna cable

Turbine @ 28mm

Kit optoelectronic reader K4 b*
Head cap for the adult masks
Permapure L73cm

Mask mouth/nose breath adult S
Mask mouth/nose breath adult M
Mask mouth/nose breath adult L
HR elastic belt

HR polar transmitter

Anti moisture filter

RH/TA probe

Power cord Schuko 2m

RS232 cable K4 b’

Cigar light adapter

Battery size AA 1,5V

Battery pack TX K4 b*

Cable power supply BNCxRF
Cable power supply RX unit
Harness K4 b” adult

Velcro strips (set 8 pieces)

Kit gas calibration

Carrying case

Holder Portable Unit

Time lag fuses 5x20 250V T500mA
Fuses 6,3x32 250V F5A

PC software

Conformity declaration
Registration card

K4 b” User Manual




Warranty registration

Before using the system, please take a moment to fill in the registration form and the
warranty and return them to COSMED, by doing this you are eligible to the customers
assistance service.

For further information, please refer to the enclosed registration and warranty form. If
the form is not enclosed in the packaging, please contact directly COSMED.

Register the product via software

Together with the PC software, a registration software is supplied. With this software it
is possible to fill in an electronic form with the customer information.

1. To run the software, double click on the icon Registration or select Registration...
from ? menu.

2. Type the requested information and click Send... to send the form via e-mail to
COSMED.

How to contact COSMED

For any information you may need, please contact the manufacturer directly at the
following address:

COSMED S.r.l.

Via dei Piani di Monte Savello, 37
P.O.Boxn. 3

00040 - Pavona di Albano

Rome - ITALY

Voice: +39 (06) 931.5492

Fax: +39 (06) 931.4580

email: customersupport@cosmed.it
Internet: http: //www.cosmed.it

Complain, feedback and suggestions

If you have any complain, feedback information or suggestion, please inform us at
complain@cosmed.it.
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Options/Accessories

Accessories

Options
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Code Quantity Description

C02150-01-11
C00600-01-11
C02115-01-10
C01278-01-30
C01277-01-30
A 800 900 004

Adapter Spirometry kit x opto-reader 2000

3 liters syringe for flows and volume calibration
Adult face mask with x Turbine 2000

Mask mouth/nose breath ID28 paediatric L
Mask mouth/nose breath ID28 paediatric S
Paediatric Headcap

Telemetry data transmission

The optional Telemetry data transmission allows the researcher to transmit data on line
to a PC up to a distance of 800 meters. All signals are in real time transmitted via radio
to the RU to be saved and displayed on-line to any PC.

Spirometry Kit

Optional software and accessories designed for performing screening Spirometry such
as Forced Vital Capacity, Slow Vital Capacity, Maximum Voluntary Ventilation and
broncho-challenge tests.




PC configuration required

e Pentium 133 MHz.

e  Windows 95, 98, XP.
e 16 MbRAM.

e 3.5drive.

e VGA, SVGA monitor.

e Serial Port RS 232 available (2 serial ports in case of Ergometer control). An USB
port can replace one RS232 serial port, if using the USB-RS232 adaptor (Cosmed
code A 388410 001).

e Any Mouse and Printer compatible with the MS Windows™ operative system.
e PC conform to European Directive 89/336 EMC

Chapter 1 - Getting started - 25




Technical features

Portable Unit

Memory

Display LCD
Keyboard:

Serial Port

Power supply:
Thermometer:
Barometer:
Dimensions PU :
Dimensions battery:
Weight:

Receiver Unit
Transmission range:
Battery:

Dimension:

Weight:

PC interface:

Battery charger Unit

Power supply
Power consumption

Flowmeter

Type:

Flow Range:
Accuracy:
Resistance:
Ventilation Range:

Oxygen Sensor (O,)
Response time:
Range:

Accuracy:

16,000 breaths

2 lines x 16 characters

waterproof, 6 keys

RS 232C

Ni-MH rechargeable batteries 3 hours endurance
0-50°C

53-106 Kpa

170x55x100 mm,

120x20x80 mm

400g

800 meters
4x15VAA

170 x 48 x 90 mm
550 g

RS 232

120V -240 V
25W

Bidirectional digital turbine @ 28 mm
0,03-20 L/sec

+2%

<0.7cmH, O s/L @ 12 L/s

0-300 litres x min

<150 ms
7-24% O,
+0.02% O,

Carbon Dioxide Sensor (CO,)

Response time:
Range:
Accuracy:

Humidity absorber

<150 ms
0-8%
+0.01%

Capillary of Nafion (Permapure ®)

Power Supply

Voltage:
Power consumption

100V-240V +10%; 50/60Hz
60W

Environmental Sensors

Temperature:
Barometer:
Humidity:
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0-50°C
400-800 mmHg
0-100%







Pulmonary function tests and measured parameters

Breath by Breath exercise testing

Symbol UM Parameter

vO2 ml/min Oxygen Uptake

VCO2 ml/min Carbon Dioxide production
Vit 1 Tidal Volume

FetO2 % End Tidal O2

FetCO2 % End Tidal CO2

R - Respiratory Quotient

VE 1/min Ventilation

HR 1/min Heart Rate

Qt 1 Cardiac output

AT - Anaerobic Threshold

VE I/min Ventilation

SV 1/min Stroke volume

RF 1/min Respiratory Frequency
FeO2,FeCO2 % Averaged expiratory concentration of O2 e CO
VE/VO2 - ventilatory equivalent for O2
VE/VCO2 - ventilatory equivalent for CO2
VO2/HR ml/beat Oxygen pulse

VO2/Kg ml/min/Kg VO2 per Kg

Ti, Te, Ti/Ttot sec time breaths

Vd/vt --- Vd/Vt ratio

PaCO2 mmHg arterial PCO2 (estimated)
P(a-et)CO2 mmHg Delta PaCO2 — PetCO2

Indirect Calorimetry

Symbol Uum Parameter

EE Kcal/day Energy Expenditure

EE/BSA Kcal/day/m® Energy Expenditure/Body surface area
EE/Kg Kcal/day/Kg Energy Expenditure pro Kg
FAT Kcal/day Fats

CHO Kcal/day Carbohydrate

PRO Kcal/day Protein

FAT% % % Fat

CHO% % % Carbohydrate

PRO% % % Protein

npRQ — Respiratory quotient not protein

Lactate Threshold (V-Slope)

Symbol UM Description

VO, @ LT I/m Lactate (Anaerobic) Threshold STPD
R@LT -- Respiratory Quotient @ LT

Time @ LT hh:mm:ss Time @ LT

VCO, ml/min CO2 output @ LT STPD

VE 1/min Ventilation @ LT BTPS
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02 Kinetics

HR bpm Heart Rate @ LT
Parameter UM  Calculation

O, deficit I/'m  VO2@work*tau

O, debt I'm  VO2'@work*tau

Spirometry Tests (option)

FVC - Forced Vital Capacity

Symbol UM  Parameter

FVC 1 Forced Expiratory Vital Capacity

FEV1 1 Forced Expiratory Volume in 1 sec
FEVI/FVC% % FEV1 as a percentage of FVC

PEF I/sec  Peak Expiratory Flow

FEVO0.5 1 Forced Expiratory Volume in 0.5 sec
FEV6 1 Forced Expiratory Volume in 6 sec
FEV1/FEV6 % FEV1 as a percentage of FEV6
FEV6/FVC% % FEV6 as a percentage of FVC

Best FVC 1 Best Forced Expiratory Vital Capacity
Best FEV1 1 Best Forced Expiratory Volume in 1 sec
Best PEF I/sec  Best Peak Expiratory Flow

Vmax25% I/sec  Expiratory Flow when 75% of the FVC remains to be exhaled
Vmax50% I/sec  Expiratory Flow when 50% of the FVC remains to be exhaled
Vmax75% I/sec  Expiratory Flow when 25% of the FVC remains to be exhaled
FEF25-75% I/sec  Mid-exp flow between 25-75%FVC
FET100% sec  Forced expiratory time

FEV2 1 Forced Expiratory Volume in 2 sec

FEV3 1 Forced Expiratory Volume in 3 sec
FEV2/FVC% % FEV2 as a percentage of FVC
FEV3/FVC% % FEV3 as a percentage of FVC
FEV1/VC% % Tiffenau index

FEF50-75% I/sec  Mid-exp flow between 50-75%FVC
FEF75-85% I/sec  Mid-exp flow between 75-85%FVC
FEF0.2-1.2%  lsec Mid-exp flow between 0.21-1.21

FivC L Inspiratory Forced Vital Capacity
FiF25-75% I/sec  Forced mid-inspiratory flow

Fivl I/sec  Forced Inspiratory Volume in 1 sec

PIF I/sec  Peak Inspiratory Flow

VEXT ml  Extrapolated Volume (back extrapolation)
PEFT msec Time to PEF (10% - 90%)

VC/IVC - Slow Vital Capacity and Ventilatory pattern

Symbol UM  Parameter

EVC 1 Expiratory Vital Capacity
IvC 1 Inspiratory Vital Capacity
ERV 1 Expiratory Reserve Volume
IRV 1 Inspiratory Reserve Volume
IC 1 Inspiratory Capacity
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VE I/min Expiratory Minute Ventilation
Vit 1 Tidal Volume

Rf 1/min Respiratory Frequency

Ti sec  Duration of Inspiration

Te sec  Duration of Expiration

Ttot sec  Duration of Total breathing cycle
Ti/Ttot —-  Ti/Ttot ratio

Vi/ti I/sec  Vt/ti ratio

MVV - Maximum Voluntary Ventilation

Symbol UM  Parameter

MVV I/min Maximum Voluntary Ventilation
MVt 1 Tidal Volume (during MVV)
MRf 1/min Maximum Respiratory frequency
MVVt sec  MVYV duration time

Bronchoprovocation Response

Symbol UM  Parameter

FallFEV1 % Fall in FEV1 from baseline or post diluent

FallVmax50% % Fall in Vmax50% from baseline or post diluent

P10 —-  Provocative dose causing FEV1 to fall 10% from baseline
P15 —-  Provocative dose causing FEV1 to fall 15% from baseline
P20 —-  Provocative dose causing FEV1 to fall 20% from baseline







Installation sequence

Before starting operating with the system make sure to meet the environmental and
operational conditions reported in Chapter 1.

Battery Charger Unit

Plug for car charging adapter
Voltage switch

PU power supply plug

Main plug

ON-OFF switch

The Battery Charger Unit allows the following functions:

e Charge 3 rechargeable batteries simultaneously.

e  Charge batteries by means of the car lighter plug.

e Supply the K4 b’ Portable Unit directly by the main power.

Check voltage
AAA

Warning: Before turning the The Battery Charger Unit is provided with a switch that allows to change the voltage
Battery cfharger Unit on, check according to the following values:

the voltage switch selected ° 115V 50-60 Hz (100V-120V)
meets your main voltage.
e 220V 50-60 Hz (200V-240V)

To change setting, move the switch on the new voltage by using a small screwdriver or
a pen.

Turn the Unit on
1. Connect the Charger Unit to the main plug.
2. Turn on the Unit by pressing the orange power switch.

Charge the batteries
1. Insert the batteries into the places on the top of the unit as shown in the illustration
below.

2. The small green LED placed on the front panel warns the charge in progress. The
battery is charged when the light signal placed on the front panel of the Charger
Unit starts blinking.

Charger Unit (CU)

Battery

LED charging indicators
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Poriable Unit

Battery low

It is recommended to charge batteries before each test. When the batteries are low the
warning message is prompted on the PU by two beeps for an half charged battery and
three beeps for a complete discharged battery.

As soon as the message appears, you must change batteries immediately since the
system has only few minutes of endurance still available. The system allows to change
the battery during testing as well.

During the test, it is possible to monitor the battery status in real time by selecting
Information from View menu.

The PU can be supplied either by the Charger Unit or by rechargeable batteries. It is
recommended during Warm-up to supply it exclusively by the Charger Unit time in
order to save the battery used normally during the test.

The control panel of the Portable Unit is mainly composed by a keyboard, and 4 plugs
for power supply, turbine, antenna, heart frequency and sampling tube connections. The
following illustrations show in detail the control panel.

v $COSMED W h

S Antenna A HR-Temp.
€ Sampling
Turbine LJ

Marker key
Display

Cancel key

Enter key

Scroll up/down key
On/Off switch

mm g QW

Connections

Temperature & HR probe
6V Power Cable

Turbine
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AAA Warm up

Important: In order to ensure Ty K4 b2 yses O, and CO, heated sensors. We strongly recommend at least 45 minutes
accurate gas measurements,

you must wait for a warming-up Warm-up time at an ambient temperature of 20°C. More time is necessary if the
time before operating the K4 ~ environmental temperature is lower. Calibration or testing before warm-up time is

b?. During this period the PU  completed, can cause wrong results.
must be turned on for at least

45 minutes.
minutes Warming-up the unit by main power
AAA 1. Connect the Charger Unit to the main power by the AC power cable.
Warning: Supply K4 b? with 2. Connect the power-supply cable both in the Charger Unit and K4 b” as shown
C’;afgef Unit for warming up below and turn both the units on.
only. -

Power supply cable

Turning on/off the portable unit
To turn the K4 b’ on or off press the on/off key.

Connect the rechargeable battery

Plug the power supply cable into the battery socket as shown in the following
illustration.

Short antenna

Power supply cable

i

]

AAA Lo

Warning: During testing make ) . ’ . .

sure to change the battery as ~ Sometime you might need to change the battery during the test. To do this you must
fast as possible, since along  change the battery in the shorter time possible. The Portable Unit does not transmit data

time could compromise the while it is not powered.
reliability of measurements.
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Receiver Unit

Optionally the K4 b” is provided with a transmitter board (located inside the K4 b unit)
and a Receiver Unit to monitor "on-line" exercise tests performed either in the field or
in the lab. All data measured by the K4 b” are transmitted "breath by breath" to the
Receiver Unit in real time. The RU (illustrated below) must be connected to a Personal
Computer with any RS 232 serial port to display data "on-line" in the management
software. The transmission range is 800 meters in open field. However during
transmission the test is stored in the memory of the K4 b* Unit so that, in case of
transmission interference no data is lost.

.

'

6V DC for battery and
main power supply

Battery Level Indicator

On/Off Switch

Turning on/off the receiver unit
To turn the receiver unit on or off use the switch on the front side of the unit.

Receiver unit power supply

The K4 b* Receiver Unit is provided with four 1.5 V AA batteries. Before turning the
unit on be sure that batteries are charged. If the status battery indicator blinks red you
must replace the 4 batteries. The unit can be also supplied by 6V DC power through the
cable provided in the equipment.

The receiver unit can be supplied by two different sources:
e by the Battery Charger Unit: connect the units by the 6V DC cable.
e by4 AA 1,5V batteries.

Calibration Gas Cylinder

In order to calibrate the sensors you need to have available calibration cylinder with the
following gas concentration:

Cylinder Recommended Gas mixture

Calibration 0, 16%, CO, 5%, N, Balance
For the calibration procedure, see the Calibration chapter.
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Connecting the K4 b? to the patient

K4 b?is a portable system with a total weight lower than 1 kg. Cosmed has developed a
special harness to fix the unit to any subject. The harness consists of a belt that can be
adjusted to fit different sizes and positions. L.e. if you need to test cyclist or rower
athletes we recommend to locate both units (K4 b” and battery) on the back of the
subject to increase comfort and to avoid any obstacles during movements. For this
reasons plates are provided with the harness and they can be easily removed and placed
in different positions.

Assemble the mask and the flowmeter

AAA

Notice: In order to preserve
items composing the mask, it's
recommended to grease
periodically O-rings in the
optoelectronic reader with
Silicone compound grease.

K4 b? is provided with a turbine flowmeter that can be easily disassembled for allowing
cleaning and disinfection.

1. Plug the turbine in the mask adapter by pushing and rotating it clock-wise till you
feel a stop.

Insert the optoelectronic reader over the turbine and press it till the mask.
3. Plug the wind cover as described in point 1.

Plug the sampling tube in the little hole located in the optoelectronic-electronic
reader.

5. Plug the turbine cable in the Turbine plug control panel of the K4 b’.

Headcap

Inspiratory valve
Turbine

Optoelectronic
reader

@\Wind cover

Sampling plug

=(alt—

Using the "Ultimate Seal"
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The "ultimate seal" is a moulded of Elasto-Gel, a glycerine based hydrogel. This
product is a unique polymer gel that forms an intimate seal between the face and the
mask. It has to be used for mask applications on hard to seal faces and where leaks are
not tolerated.

e  Will not irritate the skin
e  Contains no adhesives.
e Has no odour

e  Will not dry out

¢ Single patient use




AAA

Notice: Avoid the exposure
to the sun. Do not put the
seal into the water.

Apply the seal to the mask

Apply seal to clean, residue-free mask only and follow the instructions below:

4.

Remove the plastic tray from the bag. Peel off clear film and retain for later use.

While holding tray align the nose area of mask to nose area of Ultimate Seal™ gel.
Press together and roll mask down over the surface of the gel seal attaching it to the
mask and releasing it from the tray.

If needed, adjust the position of the seal, aligning it with the outer perimeter of the
mask sealing surface.

The mask is now ready to be placed on the subject's face.

To remove seal on mask

The Ultimate Seal™ have been conceived for a single patient use only, it can not be
cleaned or sterilised.

If mask requires cleaning for a new patient application then pull off and dispose of
the Ultimate Seal™.

To keep the seal clean between use, keep it attached to the mask and place the clear
film against the Ultimate Seal™ gel on the mask. When the seal becomes
discoloured or opaque (approximately two weeks) dispose of the current seal and
replace it with a new one.

Assembling the flowmeter for spirometry tests

In case the spirometry kit option is purchased assemble the turbine as shown in the
illustration below.

Spirometry mouthpiece
adapter

Turbine

Optoelectronic reader

TN

Cover wind

/
/
== f !
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Fixing the K4 b? to the patient

AAA

Notice: Be sure to fix the
Heart rate probe on the left
side, while the other cables
have to be fixed on the right
side. This must be done for
avoiding interferences
between cables.

AAA

Notice: Fix all cables with
the velcro strips provided
with the equipment.
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1.
2.

Fix the heart belt to the patient’s box thorax.

Fix the K4 b unit to the front of the harness. Do the same operation with the battery
on the back .

Connect the battery cable to the 6V plug of the K4 b control panel. Be sure that the
red plug, that repairs the plug from water or sweat drops, is on the Portable Unit
side.

Connect the antenna cable to the Antenna plug of Portable Unit control panel.

Insert the heart frequency receiver and temperature probe cable in the HR-Temp
plug placed on the control panel.

Insert the male connector of the turbine in the Turbine plug on the control panel.

Fix the power supply cables, antenna and turbine on the right side of the jacket with

the velcro stripes provided in the equipment. Fix the heart frequency probe on the
left side.




Connecting the K4 b? to the PC

K4 b* can be connected to any PC provided with serial port in order to monitor "on-
line" physiological data during any kind of activity.

Connect the Portable Unit to the PC

Connect the K4 b® Portable Unit to a serial port available in the PC. Be sure to set the
K4 b* software to the proper serial port for the transmission.

g 52

Serial Connection

Connect the Receiver Unit to the PC

Connect the telemetry module to a serial port available in the PC. Be sure to set the K4
b” software to the proper serial port for the transmission.

P
k; oL

K4 serial p - PC Serial plug

-
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Software installation

The software is made of two programs: one for the ergometry and the other one for the
spirometry (option). The two programs share the same archive and use the same
program for the system calibration, even if they are used for performing completely
different tests.

Installing the software
1.

AAA

Notice: The software is
copy-protected. Install the
software from the original
disk.

Run the software

2.
3.
4
5

Select Run... from Windows Start menu.

In the Command line box, type a:\install (assuming the disk is in drive A:).

Click on OK (or press ENTER key).

The program will load up a dialog box and ask for a directory where to be installed.

When the installation is over, the program will advise you with a message
indicating that the installation has been successfully completed, click on End.

Note: the directory for the Spiro software must be the same of the K4 b’ (ergo).

1.

2.

PC port configuration

The first time the software is used, it is necessary to configure the communication port
with the PC (USB, COM1, COM2,...).

For further details, see the chapter Database management.
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In the Windows Start menu, open the Program Group in which the software was
installed.

Click the K4 b* icon.




Software main features

Display

Tool bar

Dialog windows

Scroll bars

On line help

Software version

The program may contain several windows. The active window is highlighted with a
different colour of the caption. Some functions of the program are "active window"
sensitive (Print, right key of the mouse).

Many of the functions that may be selected from the menu can be activated more
rapidly by clicking with the mouse on the corresponding icon in the tool bar.

Positioning the mouse cursor on one of the buttons of the toolbar (if the option Hints is
enabled), the description of the corresponding function is shown in a label.

Show/hide the toolbar
Select Toolbar from Options menu in order to show or hide the toolbar.

The typical operating environment of Microsoft Windows is the Dialog box. This
window is provided with a series of fields in which input the information.

Use of the keyboard

e To move the cursor among fields, press the Tab key until you reach the desired
field.

e  Press the Enter key to confirm the information input on the dialog box or press the
Esc key to cancel changes.

Use of the mouse

e To move the cursor among fields, move the mouse on the desired field and left-
click.

e C(Click on the OK button with the Left button of the mouse to confirm the
information input on the dialog box or click on Cancel button to cancel changes.

Some windows are provided with scroll bars that help to see data exceeding the window
space available.

e To move the scroll bar row by row click the scroll arrows at the end of the scroll
bars

e To move the scroll bar page by page click on the grey area at both sides of the
scroll fields

COSMED K4 b* Help is a complete on-line reference tool that you can use at any time.
Help is especially useful when you need information quickly or when the user manual is
not available. Help contains a description of each command and dialog box, and
explains many procedures for accomplishing common tasks.

To get the Help on line, press the F1 key.

To know the software version and the serial number of the software, select About...
from ? menu.
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Calibration




Gas calibration procedures

The system can be calibrated according to the following procedures:
1. Room air calibration

2. Reference gas calibration

3. Delay calibration

4. Turbine calibration

The Room air calibration, forced by the system before every test, consists of a sampling
room air. It updates the baseline of the CO, analyzer and the gain of the O, analyzer, in
order to match the readings with the predicted athmospheric values (20.93% for O, and
0.03% for CO,).

The Reference gas calibration, recommended to be carried out daily, consists of
sampling a gas with a known composition (i.e. 16.00% for O, and 5.00% for CO,) from
a calibration cylinder, and updating the baseline and the gain (span) of the analyzers in
order to match the readings with the predicted values (i.e. 16.00% for O, and 5.00% for
COy).

The Delay calibration, recommended to be carried out ones a week or whenever the
sampling line is replaced, is necessary to measure accurately the time necessary for the
gas sample to pass through the sampling line before being analyzed.

The Turbine calibration, recommended to be carried out quarterly, consists in measuring

the volume of a 3 litres calibration syringe and in updating the gain of the flowmeter in
order to match the predicted value.

Running the Calibration program

&

Log file

Start the program and choose Calibration from the Test Menu. The software runs the
Calibration software and the main menu changes accordingly.

The program creates and updates as default the calibration log file, containing the
conditions and the results of all the calibrations performed by the user.

To access the file select File/Report File... from the calibration program.

Setting reference values
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Before starting calibrating make sure that the system has been configured correctly by
setting the right values of gas concentration of: room air (i.e. 20.95% O, and 0.03%
CO,), of gas mixture contained in the cylinders and the volume of the calibration
syringe (i.e. 3 litres).

Set the reference values using the PC software

This operation must be performed only the first time. The next times, the system keeps
stored the reference values entered in this step.

1. Select Reference Values from the Calibration menu.

2. Type the correct values for the O, and CO, room air concentration (i.e. 2093 for
20.93%), and do the same for the gas concentration of the calibration cylinder.

— Cylinders [Zx100) Envil t [Zx100])
o2 1604 02: 2033
coz 502 coz 3
 Syringe [ml)
118 I Cancel |
3000
Yolume: I Default | Help |

3. Type the volume of the calibration syringe (i.e. 3000 for a 3 litres calibration
syringe).
4. Press OK button to confirm changes.




Set the reference values using the Portable Unit

To set reference values from the K4 b? Portable Unit go to the main menu, choose
Calibration and scroll tasks up to choose Set Cal. Predicted Values, type the values
using the arrow keys and press Enter to confirm changes.

Room dair calibration

AAA Room Air calibration is forced to be performed before each test. With this procedure the
Note: After turning on the system calibrates both gas analyzers according to the Room Air Concentrations
unit, wait 45 minutes warm (5 959, 0, and 0.03% for CO,). You can run this procedure either with the software or
up ?‘lme'before starting the directl ith the Portable Unit

calibration procedure. ywl ¢ rortable Umit.

Room air calibration using the PC software

AAA 1. Connect the Portable Unit to the PC by the serial port. Remove the sampling plug
Important: During from the flowmeter.

calibration always remove . . . . .

the sampling tube from the 2. Run the calibration program and choose Room air from the Calibration menu.
optoelectronic reader. Do 3. The message "Room air calibration in progress..." will appear and a graph will
not remove the sampling show in real time the O, and CO, calibration. At the end of the manoeuvre the

tube from the Portable Unit
otherwise calibration could
be affected. 4. The following dialogue box will appear showing the calibration results, press OK

to confirm the calibration.

message "Calibration done" will be visualized.

Analyzers Calibration Results X
AAA ” =
Caution: During Room Air
calibration be sure to put the
sampling line far from the
expired gas otherwise
calibration could be affected.

Date: 21701797
Time from start-up: 0.06.33

Air temperature [*C):

Intemal temperature [*C):

FERRR

Atmospheric pressure (mmHg): 7
Analyzers pressure [mmHg): 7
AAA ) ) . Humidity [Z):
Caution: Room Air calibration
performed in small ambients ~Dxigen | [ Carbon Dioxide

(high concentration of CO,)
affects the calibration results
and the accuracy of the
following test. Base line (mV): I 296 I 526
Gain: I 1023 Gain: I 1605
Delay [ms): 673 Delay [ms): I 592

OK | Cancel | Default | Help |

Cylinder (%): 15.05 Cylinder [(%). 6.02

Base line (mY¥):

Room air calibration using the Portable Unit
1. Remove the sampling plug from the flowmeter.

2. In the main menu choose Calibration menu, choose Room Air Calibration and
confirm by pressing Enter.

Do not breath..
02:20.7 C02: 0.4

3. The procedure is automatically performed until the message "Calibration done"
appears, the O, and CO, values will be visualized on the display.

Calibration done
02:20.9 C02:0.0

Reference gas calibration

AAA The software allows to automatically calibrate zero, gain and alignments of the gases
Notice: Do not use mixtures  sensors. Even if the program doesn't force you to carry out the calibration, the system

with a O, concentration above ghould be calibrated before each test. To perform the sensor calibration is necessary to
24% since it is out of the

oxygen sensor range
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have available a cylinder filled of a concentration known of mixed gas. It is suggested
to use CO, 5,00% , O, 16% concentrations and N, for balance.

The calibration unit

AAA The gas regulator has an adjustable second stage that must be open every time the
Notice: Before calibrating be Cylinder is used for the calibration. This is necessary to avoid a small leakage in the

sure the "Reference values" connections can discharge the bottle in few time.
of room air and reference
gas are properly entered.

AAA N

Caution: Be sure that the

1. Make sure you wait for warm-up time before starting calibrating. Be sure the high-
pressure tube supplied together with the system is connected to the "Cylinder" plug.

Open the cylinder valve by turning the valve counter-clockwise, the pressure value

cylinder pressure out is must be set within a range of 300-500 Kpa (3-5 bars or 44-73 Psi).
regulated to 3 and 5 bar.
P —_—— ~
7 AN
AAA Output Pressure from cylinder / \

must be set between 3 and 5 barsl '

Notice: If the pressure
regulator is set at a different
pressure from what
specified, room air could be
mixed together with
reference gas and the
calibration could be affected.

Recommended gas mixture

02 (Oxygen) 16%
€02 (Carbon monoxide) 5%
N2 (Nitrogen) Balance

After these operation, please operate as follows.

Reference gas calibration using the PC software

AAA 1. Connect the K4 b* unit to the PC by the serial port. Remove the sampling plug from

Notice: Before calibrating be the optoelectronic reader.

sure the "Reference values”

of room air and reference

gas are properly entered. 3. The message "Gas calibration in progress..." will appear and a graph will show in
real time the O, and CO, calibration. The software runs first the Room Air
calibration, so do not connect the sample plug to cylinder output until the message
"Sample reference gas..." will be displayed. At the end of the procedure the
message "Calibration done" will be visualized.

Run the calibration program and choose Gas from the Calibration menu.

4. The dialogue box showing the calibration results will appear, press OK to confirm
the calibration.

Reference gas calibration using the Portable Unit
1. Remove the sampling plug from the flowmeter.

2. In the main menu choose Calibration menu, choose Refernce gas calibration and
confirm by pressing Enter.

Do not breath..
02:20.7 Cco2: 0.4

3. The K4 b’ runs first the Room Air calibration, so do not connect the sample plug to
cylinder output until the message " Sample reference gas..." will be displayed. At
the end of the procedure the message "Calibration done" will be visualized.
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Calibration done
02:16.0 C02:5.0

Gas delay calibration

The delay calibration procedure is a calibration included in the software due the time
alignment between flow and gas concentration measurements is one of the potential
problems to consider to assure accurate readings during test. The gas delay calibration is
the measurement of time required by the gas to reach the gas analyzer.

For "breath by breath" analysis it is essential that the instantaneous flow rate must be
multiplied by the proper time-matched expired gas concentration. Although flow can be
instantaneously measured, gas concentration measurements can be calculated with a
delay related both to the time necessary for the gas to be transported to the sensor and to
intrinsic characteristics of the analyzer principle.

Two factors contribute to the time alignments delay. K4 b* uses a capillary sampling
tube with a pump to draw a continuous gas sample into the analyzers. The gas transport
time depends on the dimensions of the tube and on the pump flow rate. Additionally the
gas sensors have a response time that must be added to the above delay for calculating
the total delay.

The software of the K4 b” by carrying out the Gas Delay procedure calculates this delay
and introduces a correction to realign both flow and gas measurements.

This procedure must be carried out each time some changes occur in the sampling
system, i.e. when the sampling tube is changed. However it is recommended to carry
out this calibration each week in order to prevent wrongs measurements.

Delay calibration using the PC software

1. Connect the K4 b? unit to the PC by the serial port. Remove the sampling plug from
the optoelectronic reader.

2. Run the calibration program and choose Delay from the Calibration menu.

3. The message "Gas calibration in progress..." will appear and a graph will show in
real time the O, and CO, calibration. The software first runs the Room Air
calibration. At the end of the Room Air calibration the following message appears.

Analyzers Calibration E3

-
'\l) Connect the sampling line to the flowmeter and press OK button to continue

I ﬂ(‘ ” annulla I

4. Connect the sampling tube to the optoelectronic reader and press OK button to start
breathing at a constant rate.

5. The software helps to maintain a constant rate by means of a beep sound. It is not
important to maintain the same rate suggested by the system but it is very important
to breath constantly.

6. Continue breathing some cycles until the message "Calibration done" appears. The
software open a dialogue box with the new calibration factors and the new delay
value. Press OK to confirm the calibration.

Delay calibration using the Portable Unit

1. On the main menu scroll the commands, choose Calibration and press Enter to
confirm the choice.

2. Choose O,/CO, delay calibration and press Enter to confirm.

3. The following message appears, and the software automatically run the Room air
Calibration.

Do not breath..
02:20.7 C02: 0.4
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4. When the message “Connect the sampling line and press Enter” appears press
Enter and start breathing at a constant rate. The software helps to maintain a
constant rate by means of a beep sound. It is not important to maintain the same
rate suggested by the system but it is most important to breath constantly.

5. After some cycles a message will appear confirming the delay calibration and the
new values will be shown on the display. Press Cancel to return to the previous
menu.

Print the calibration report
In the Calibration program choose Print from the File menu.

Edit the calibration factors

The last sensors calibration factors can be either edited or viewed. To do this choose
Gas Results... from the File menu.

To view or edit the last Turbine calibration factor choose Turbine results... from the
File menu.

Note: To restore factory setting press Default button in the dialog box. Once you press
the default button you must run a new calibration before testing.
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Turbine calibration

The system uses a turbine flowmeter. It opposes a very low resistance to flow. The air
passing through the helical conveyors, takes a spiral motion which causes the rotation of
the turbine rotor. The rolling blade interrupts the infrared light beamed by the three
diodes of the optoelectronic reader. Every interruption represents 1/6 turn of the rotor,
this allows to measure the number of turn in the time. There is a constant ratio between
air passing through the turbine and number of turns. This allows an accurate measure of
flows and volume. The turbine flowmeter doesn't need daily calibrations as it is not
affected by pressure, humidity and temperature.

To work properly, the turbine only requires the rotor to rotate freely without any friction
that might be caused by dust that can be easily avoided with an ordinary cleaning
procedure (see Maintenance).

However in order to ensure accuracy it's recommended to run periodically the
calibration procedure. Calibration has to be carried out with a calibration syringe of 3
litres volume, the calibration procedure is totally managed by software.

A measurement system should be calibrated daily in order to ensure maximum accuracy
and reliable test results. If a correct maintenance is provided it’s possible to check the
calibration of the turbine flowmeter even at relatively long intervals (i.e. 1 month). The
calibration procedure assures valid and verifiable results within a +3% accuracy.

Assembling the flowmeter for calibration
1. Connect the Opto-reader to the calibration syringe through the adapter.

2. Connect the flowmeter to the syringe with the rubber cylinder supplied in the
standard packaging.

&y 7

Syringe

Adapter for calibration
syringe

Note: If a bacterial filter is used for the tests, do use it also during the turbine
calibration.

Calibrating the turbine

AAA

Note: If you are using a slow

PC, we recommend to set
an higher refresh time.

Turbine calibration using the PC software
After having run the calibration program:

1. Select Reference Values from the File menu. If your syringe has a different value
from the default one (3 litres), please enter the correct value.

2. Select Calibration/Turbine....

3. When the Calibration Turbine dialog box appears with the syringe piston initially
pushed all the way in, move the piston in and out for 5 inspiratory strokes and 5
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expiratory strokes in order to get the first values appearing on the display. Then
move the syringe piston for other 10 strokes (IN and EX).

Turbine Calibration E

Syringe volume: 3000 ml

Results
Exp. b4 Gain Ing. X Gain
3002 +0.07 1046 2993 -0.23 1027
2985 -0.50 1048 2995 -0.17 1028
2972 -0.93 1052 3010 +0.33 1026
2993 -0.23 1052 2993 -0.23 1027
3019 +0.63 1051 2984 -0.53 1027
2992 -0.27 1051 2990 -0.33 1028
2994 -0.20 1051 3004 +0.13 1027
3009 +0.30 1050 3008 +0.27 1027
2988 -0.40 1051 2996 -0.13 1027

2974 -0.87 1051 3006 +0.20 1027

Iane the calibration syringe...

4. At each of the 10 steps the software displays the results of the manoeuvre and the
percentage error in the reading.

5. At the end of this operation, the software displays the new calibration factors. Press
OK to store the new value.

Turbine Calibration Results E3

Date: 26/01/97
Syringe [ml): 3000

Type [(mm]): I
Gain Exp.- I 1038 Cancel
Gain Ins_: I 1054 Default

Help

PR

Turbine calibration using the Portable Unit
1. Screw up the adapter for the calibration syringe to the optoelectronic reader.

2. Connect the optoelectronic reader to the calibration syringe. Before starting the
calibration be sure to have inserted the right reference value for the syringe. To
check it, select Volume Syringe from the Set predicted value menu.

Syringe volume
vol:3000 ml

3. Then choose Calibration from the main menu and press Enter.

Scroll the menu, choose Turbine Calibration and press Enter.
5. Start moving the syringe till the message "Operate syringe” will disappear on the

display. The display will show expired (E) and inspired (I) readings for each stroke.
Operate syringe
#x/8E:29261:2936

6. When the display visualizes the message "Calibration done" the Turbine has been
calibrated, press Cancel to return to the main menu, the new calibration factor will
be automatically stored.




Checking the system signals

The control panel

The Control Panel, which can be activated from the Calibration/Control panel...
menu item, is a useful tool to check the main hardware functions of K4 b’.

By using the controls on Control Panel you are able to do the following:
1. Reading the signals acquired by the system both as voltages and processed data;

2. Activating/Disactivating the valves, the sampling pump and other installed
components (for example, oxymeter).

Control panel |
mvl % I Iﬁ @ I @ I \/I xl Hefi%[m;ﬂc]
CO2 Trimmer

[w |02 [m¥] 3863 3 :
[/ |CO2 [m¥] 102

7 [Ambient temp. [mY] 267  Mossages: EI
W Internal temp. [m¥] 399

v Barometnc press. [m¥] If12

v Analyzers press. [mY] 3566

I~ B attery voltage [m¥] 3800

v Heart rate [msec] 678

v Turbine Flow [mlfzec] nz

v Turbine ¥olume [ml] m

Cloze I Help

Using the control panel

mV / real values Selectall ~ Deselectall g0 refresh
Flowmeter Buzzer channels channels

display on/off on/off time

@ Refrezh [mzec]
L
mV| 35 I 1 ﬂlI@I \/IXI |2uu o
A CO2 Trimmer
v [02][mv] 3863 . -
edit parameters Sampling Transmitter
(name, unit,...) pump on/off on/off Digital CO,
trimmer
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Operating modes




K4 b? Operating modes

K4 b? is a versatile system. You can use it in the field or in the lab without any kind of
limitation. Test can be carried out in the following three different configuration:

e Holter Data Recorder
e Telemetry Data Transmission

e Laboratory Station

Holter Data Recorder

Using the system in the field without the Receiver unit you can store data "breath by
breath" in high capacity memory (I MB). The memory allows to store up to 16
thousands breaths, when the test is completed, the results can be downloaded to the PC
via the RS 232 port provided with the equipment.

Telemetry Data Transmission (option)

In case the telemetry Data Transmission module is available, the K4 b* portable unit
provided with a small transmitter that allows to send data by telemetry up to a distance
of 800 meters. All data are transmitted "breath by breath" to the receiver unit. The
Receiver Unit must be connected to a PC by serial port, it allows the resercher to
monitor data on line both in table and graphic format. Anyway tests are stored in the
memory of the portable unit, thus in case of transmission interferences no data are lost.
By using the system with a PC the software K4 b’ can also control and synchronise
ergometers by using user defined exercise protocol.

Serial (Laboratory) Station
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Although K4 b® has been designed for tests in the field, it can also be used as a
conventional laboratory station as it offers the same features of the best stand alone
devices. Under this operating mode the K4 b? Portable Unit is simply connected to the
PC through the RS232 serial port and all tasks, exactly like any conventional laboratory
device. Anyway tests are stored on the memory of the portable unit as well.




Portable Unit User Interface diagram

Portable Unit User Interface diagram

On/Off i Restore Factory External
Transmitter Set Date and Time Settings Device
Settings
Enable/Disable Units of Warm up Altitude Version
Warnings Measurement time setting
Memory Status Erase Memory
Memory
functions
View test List
Start Acquisition
Test
Patient’s Data
Room Air Turbine Set. calibr. Set. calibr.
calibration calibration Predict. Values Factors
Calibration
Ref. Gas 02/CO2 Delay Control Panel GPS control
Calibration calibration
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Holter Data Recorder Mode

Operating sequence
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It is ideal operating modes if you need to test a patient difficult to monitor by Telemetry
(i.e. climbing, long distances races, etc). The memory capacity of the K4 b is able to
store data up to 16 thousands breaths. The system saves data for each breath, hence time
storing capacity depends on the respiratory frequency.

Holter Data Recorder Mode Part List

1. Mask + flowmeter

2. Heart Rate belt

3. Rechargeable Battery
4. Harness

5. K4 b2 unit

6. HR probe

7. Power cable

Warming-up the system
Warm-up the K4 b” for 45 minutes before testing or calibrating.

Enter new patient
1. Connect K4 b”to the subject.
2. Go to the K4 b’ control panel and choose Patient's data from Test menu.

l1.Patient's
data

3. Move the cursor among fields with the Enter key and use the Up and Down keys
to modify values.

H:xxx A:xx H:xxx
W:xxx S:M HR:xxx

The fields are shown in the following order:

#: patient ID

A:  agein years

H:  height (cm or inch)
W:  weight (kg or Lbs)
S:  sex(MorF)

HR: HR max

4. The HR Max is automatically calculated by the formula 220-age, however it can be
also changed according to physician experience and patient medical history. By
confirming the HR rate value all the patient data are automatically saved.

Calibrate and start the test

1. Remove the sampling plug from the mask and put the tube far from expired gas
concentrations.

2. On the Patient's Data menu scroll down the menu and select Start Test from the
main menu and press Enter to confirm.




3.

The message "Insert relative humidity" will be visualized, type the correct value
and press Enter.

Insert relative
humidity HR:xx%

4.

The K4 b? runs automatically the Room Air calibration. The message "Do not
breath near the sampling line" appears. Wait for few seconds until the message
"Calibration done" will appear together with a double beep sound.

Do not breath..
02:20.7 C0o2: 0.4

5.

Connect the sampling plug to the optoelectronic reader. Some values (Heart Rate,
R, VO,, VCO,,...) will be shown and updated each breath on the control panel
display. The message "Press Enter to start the test” will be displayed each 10 secs.
You can switch to different values by moving the Up and Down key.

After having pressed the Enter key the test starts but the K4b2 is not storing data.
In this phase the PU is checking the main parameters and you can visualize it on the
PU display by the time is blinking.

Pmm:ss#HTHR:xxx[
v

02 :xx . 4B :x.xx |

7.

To start storing data press another time the Enter key. You can check the storing
phase because the time parameter don't blink anymore.

Press Enter to..
VO2 :x.xx R.x.xx

Stop the test

To stop the test press Cancel. The message "Press enter to stop test” will appear, press
Enter to stop the test.

Transferring test to PC

Once the test is concluded you may download all data stored in the K4 b? to the
management software.

1. Turn the K4 b’ on.
2. Connect the K4 b? to the PC by the serial cable enclosed in the equipment.
3. Run the K4 b” software and choose Receive Test from the Test menu.
Test Download X
i Tests to link: 2
Test #t: 1 Temperature (‘C): 0 ID code: O
Date of test: 12707701 PB (mmHg): 740 Sex: M
Time of test: 09:49 Humidity (Z): 50 Age: 25
Duration: 00:02:43 Height [em): 170.
N_ of steps: 71 Weight [Kg): 70.0
| Extimated download time: 00:00:09

Preview | First Erevious Hext | Last |

i Link to

Progr.: 5
ID code: default
Last name: GPS Find ID codel
First name: TEST

Sex: M Download I

To download a test you must link it to an existing patient file. Choose Find and
then List to select an existing patient. If the patient is new than select Find and then
New, fill in the fields and press OK to confirm.

Select the test to link by using First, Previous, Next and Last buttons and press
Download to confirm your choice and to store the test on the Hard Disk. You can
use the Preview button to see some data and graph of the test in order to find out
the proper one.
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Telemetry Data Transmission Mode

In case you need to monitor in real time the test you can use the Telemetry Data
Transmission module that is provided by COSMED as an option. The transmission
range can reach 800 m allowing to monitor exercise testing in the field. To use this
option you need a personal computer to connect the receiver unit.

Telemetry Data Transmission Mode Part List

1. Mask + flowmeter

2. Heart Rate belt

3. Battery + Antenna

4. Harness

5. K4 b2 unit

6. HR probe

7. Power & Antenna cable
8. Telemetric Unit

9. RS232 cable

10. Personal Computer

Operating sequence

Warming-up the system
Warm-up the K4 b” for 45 minutes before testing or calibrating.

Connect the receiver unit to the PC
Connect the receiver unit to PC with the serial cable provided in the standard packaging.

Enable transmission

1. Go to the K4 b* control panel, verify that transmission is enabled by choosing
Settings /On/Off Transmitter and press Enter.

2. Enable the transmission by moving the "*" sign on Transmit. On and press Enter
to confirm settings.

Enter new patient
1. Connect K4 b?to the subject.
2. Go to the K4 b?control panel and choose Patient's data from Test menu.

l1.Patient's

data

3. Move the cursor among fields with the Enter key and use the Up and Down keys
to modify values.

H:xxx A:xx H:xxx
W:xxx S:M HR:xxx

The fields are shown in the following order:

#:  patient ID

A:  age in years

H:  height (cm or inch)
W:  weight (kg or Lbs)
S:  sex(MorF)

HR: HR max
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4. The HR Max is automatically calculated by the formula 220-age, however it can be
also changed according to physician experience and patient medical history. By
confirming the HR rate value all the patient data are automatically saved.

Enable reception on PC
1. Run K4 b® software.

2. Open patient data dialog box, select or type a new name and press OK to confirm.
The name of the selected patient will appear in the status bar of the software.

3. Choose Execute test from the Test menu.

Execute Test %]
Mode ———
Height [cm]: [T 6'05:3
Weight [Kg): [80.0 O ECG
Gas + ELCG
" Rest ECGE
[~ Telemetry
Ergometer: | [no one) j| | (1] 4 I
Protocol: m Other data... |
Cancel |

4. Type the patient information, select a protocol from the list and an ergometer if
you are going to carry out a test with an ergometer.

5. Chose Other Data if you want to insert other important informationon the the you
are going to perform.

Execute Test - Other Data %]
Y02max [ml): |[11 UN (g/day): |u.n | oK |
E¥C (1):/0.00 VD [ml): [0
Cancel |
FEV1 (1):|0.00 BH (%): |50
MYV [I/min): (0.0 RH fluss. [%); |100
1C [1):(0.00 T Huss ["C): |34

Usger 1: Illl]l] B ok oy —
User 2: IU.I]I] Distance: Il]

User 3:||1uu Un. meas.: I

6. Select the workspace you would like to see during the test (it can be also changed
during test), check the option box Telemetry to enable software receiving of data
and press OK to confirm. The software will show blank windows waiting for the
first breath.

Calibrate and start the test

1. Remove the sampling plug from the mask and put the tube far from expired gas
concentrations.

2. On the Patient's Data menu scroll down the menu and select Start Test from the
main menu and press Enter to confirm..

3. The message "Insert relative humidity" will be visualized, type the correct value
and press Enter.

Insert relative

humidity HR:xx%

4. The K4 b? runs automatically the Room Air calibration. The message "Do not
breath near the sampling line" appears. Wait for few seconds until the message
"Calibration done" will appear together with a double beep sound.

Do not breath..
02:20.7 C0o2: 0.4
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Connect the sampling plug to the optoelectronic reader. Some values (Heart Rate,
R, VO,, VCO,,...) will be shown and updated each breath on the control panel
display. The message "Press Enter to start the test” will be displayed each 10 secs.
You can switch to different values by moving the Up and Down key.

After having pressed the Enter key the test starts but the K4b2 is not storing data.
In this phase the PU is checking the main parameters and you can visualize it on the
PU display by the time is blinking.

hmm:ss#uTHR:xxx[
v

02 :xx . HR :x.xx |

7.

To start storing data press another time the Enter key. You can check the storing
phase because the time parameter don't blink anymore.

Press Enter to..
VO2:%x.xx R.x.xx

Stop the test

To stop the test press Cancel. The message "Press enter to stop test" will appear, press
Enter to stop the test.

Transferring test to PC

If some interferences should occur during test execution by telemetry, some breaths
could be lost. The software shows a message on the status bar warning that some steps
missed . Since K4 b? stores every time the complete test in the memory, it is possible to
download the test later to the management software to recover all lost data.

1. Turn the K4 b® on.
2. Connect the K4 b* to the PC by the serial cable enclosed in the equipment.
3. Run the K4 b’ software and choose Receive Test from the Test menu.
Test Download
Tests to link: 2
Test#: 1 Temperatwe [*C): 0 ID code: O
Date of test: 12/07/01 PB [(mmHg): 740 Sex: M
Time of test: 09:49 Humidity (%): 50 Age: 25
Duration: 00:02:43 Height [cm): 170.
M. of steps: 71 Weight [Kg): 70.0
| Extimated download time: 00:00:09

Pieview | First Erevious Hext | Last |

~Link to

Progr.: 5

ID code: default mi

Last name: GPS Find ID cndel Close |
First name: TEST |

Sex: M Download I

I

To download a test you must link it to an existing patient file. Choose Find and
then List to select an existing patient. If the patient is new than select Find and then
New, fill in the fields and press OK to confirm.

Select the test to link by using First, Previous, Next and Last buttons and press
Download to confirm your choice and to store the test on the Hard Disk. You can
use the Preview button to see some data and graph of the test in order to find out
the proper one.




Serial Mode

When the K4 b* is used in the serial mode the system works exactly as any other
conventional laboratory station. In this mode the software controls completely the K4 b’
portable unit so that any command such as calibration can be run by the software. You
can also drive an ergometer if a second serial port is available in the PC.

Serial Mode

Part List

. Mask + flowmeter

. Heart Rate belt

. Battery

. Harness

. K4 b2 unit

. HR probe

7. Power cable

. Telemeftric Unit

9. R$232 cable

10. Personal Computer

O AW~

©

Operating sequence

Warming-up the system
Warm-up the K4 b*for 45 minutes before testing or calibrating.

Connect the Portable unit to the PC
1. Connect K4 b’ to the PC by the serial cable

2. Check that the Serial Port is properly selected by choosing RS 232 from the Option
menu.

3. Check the Ergometer connected to PC option box if you intend to use an
ergometer for testing.

Calibrate the system
1. Run the K4 b? software and choose Calibration from the Test menu.

2. In the Calibration software select Analyzers -> Room Air from the Calibration
menu.

Enter patient data
1. In the K4 b’ software and choose Patient from the File menu.

Patients in archive
Search for Find:
& [Last name I_ Hew
D code
€ Progressive Eindl | List. | Cancel |
- Patient:

Progr: 5

Last name: GAS+ECG

First name: INCREMENTAL Modify. ..

Sex: M

Delete. .. ok | 2|

2. Select a patient from the list or press New to enter a new name and press OK to
confirm.
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Start the test

1. Open patient data dialogue box, select or type a new name and press OK to
confirm. The name of the selected patient will appear in the status bar of the
software.

2. Choose Execute test from the Test menu.

Execute Test
Mod
Height [cm): [LE{IAL FOE:s
‘Weight [Kg): [80.0 " ECG
{" Gas + ECG
{" Rest ECG
[~ Telemetry
Ergometer: | [no one] ﬂl | 1] 4 I
Protocol: |[nn one] ﬂl Other data... |
Workspace: | User 1 jl Details.... |
Cancel |

3. Type the patient information, select a protocol from the list and an ergometer if
you are going to carry out a test with an ergometer.

4. Chose Other Data if you want to insert other important informationon the the you
are going to perform.

Execute Test - Other Data X|
V0 2max [ml): |m UN (g/day]: [0.0 | 0K |
EVC (I):[0.00 VD [ml): [0
Cancel |
FEV1 (I):|0.00 BH (%): |50
MVV (I/min): |0.0 RH fluss. (%) [100
IC [1):|0.00 T fHuss ['C): |34

User 1: Illl]l] Marker
User 2 Illl]l] Distance: IU

User 3: Illl]l] Un. meas.: I

5. Select the workspace you would like to see during the test (it can be also changed
during test) and be sure that option box Telemetry is disabled since the
transmission will be done by serial cable. Press OK button to start acquisition.

6. The software displays the data according to the selected workspace. Check some
breaths and press F2 to start testing.

Stop the test

To end the test press F3, press OK in the following dialogue box to confirm the end of
the test. All data will be automatically saved on the Hard disk. Anyway test is stored on
the memory of the portable unit as well.







Exercise testing patient's database

Enter a new patient

i

Find a patient

Edit patient data

Delete a patient
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The exercise testing software uses a different interface for presenting patient

information. The patient database allows to:
e Enter a new patient

¢ Find patient data

e Edit patient data

e Delete patient data.

Select Patients from the File menu.

1. Press New to show the Patient dialog box.
2. Enter data of a new patient and press OK button to confirm.

Patients in archive E

Search for Bl

f* |.ast name I Hew

D code

£ Progressive

Endl | st | Cancel |

— Patient:
Progr.: 5
ID code: 3
Last name: GAS+ECG
First name: INCREMENTAL
Sex: M

Delete... oKk |

Previous

Modify._..

Moy |

|=a

Enter a search string into the Find field and press Find to view the data concerning a
subject already in the database. You can search for “Last name”, “ID code” or

“Progressive”.
Or:

Press List to view the list of patients in the database. Press Next or Previous to view

the data corresponding to the next or to the last patient. Press OK to confirm.

The Next and Previous buttons allow to move to the next or the previous patient in the

database.

Select the patient.
Press Modify... in order to edit the patient’s data.
3. Edit the desired values and press OK to confirm.

Select the patient to be deleted.

2. Press Delete.




Uploading tests from the Portable Unit

In telemetry and holter function you could need to upload data from the portable unit
via serial port.

1. Link up the PU to the PC with the RS232 cable supplied.
2. Turn on the Portable Unit.
3. Choose Receive Test from Test menu or press Alt F2.

Test Download
Tests to link: 2
Test#: 1 Temperature ('C): D ID code: D

Date of test: 1220701 PB (mmHg): 740 Sex: M

Time of test: 09:49 Humidity [%): 50 Age: 25
Duration: 00:02:43 Height [cm): 170.

M. of steps: 71 Weight (Kg): 70.0

| Extimated download time: 00:00:09

Preview | Eirst Erevious Hext | Last |

Link to
Progr: 5 ﬁ
ID code: default
Last name: GPS Find ID cudel Close |
First name: TEST
Sex M Download I 2 |

4. To be downloaded the test must be linked to a patient. If the current patient has
already been inserted in the database, choose Find and then List select the patient
and confirm. If the current patient doesn't belong to the archive he must be inserted,
select Find and then New, fill in the fields and confirm. Now the download
function is available and the test will be filed on the PC.

5. Choose the test to link with the First, Previous, Next and Last buttons and press
Download.

6. A status bar will show the data acquisition in progress. At the end a message will
indicate the end of data reception.

Receiving test

Receiving test ..

202
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Archive maintenance

The software allows to manage files selecting Archive from the File menu.

It is advisable to perform the archive reorganisation every month, in order to free space
on the hard disk and/or to correct possible errors present within the database.

It is possible also that your have no more hard disk space. So, you have to delete all the
data. In this case, it is useful to perform the initialising.

Reorganise the archive
1. Select Reorganize archive from the File menu.
2. Wait for the end of the operation before performing any other function.

Delete the archive
1. Select Initialize Archive from the File menu.
2. Wait for the end of the operation before performing any other function.

Delete a test
To delete an ergometry test, select Test/Delete test.
To delete a spirometry test, press the proper button in the Test Card.

Backup and restore

It is strongly recommended to backup files, a warning message will be displayed
monthly. This function allows the user to restore the data if the PC or the HD will not
work anymore.

Backup
1. Select Backup archive from the File menu.

2. Selecting the destination path with the Browse key or press New to create a new
directory. Press OK to confirm.

3. In the dialog box it will appear an estimate of the number of floppy disks you need
in order to back up the archives. Press OK.

Backup v. 5.4 E3 W rostore v. 5.4 K

Statistics Backup to:
60 files | [ HRestore from:
2 Mb Il
Description EIDWSB.. |
UK Cancel | wk I Cancel |

Restore
1. Select Restore archive from the File menu.

2. On the Restore dialog box specify the drive source and press OK, a dialog box
will appear indicating all data of the backup processed.
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Spirometry patient's database

iy

AAA

Note: after having deleted a
record (patient, visit or test),
it is recommended to
reorganize the archive in
order to free disk space.

The Patients database consists of a Patient Card, a Visit Card and a Test Card in which
are listed all tests performed by the patient.

Select Archive Navigator from the File menu or press the button by side.

[The rchive Navigator
Patient Card ‘ Tests to Display
|i|g [ ] T Soi by ib: 0971071995 - FYC
Name [1001 Last |1|]n1— I%
1p[10m Male [=| Birth[01/01/1975 FEVT
4. 41
Visit Card \
@ [<] «|»[»1]@] pate: 03/10/1995 EP::

[y — B3 —
Height [cm) [180. Weight (Kg) I?l]. Age |2U nckd | kel

Smoke Diug IDHUE
“Mo  Yes ¢ Ex ¥ Iu Cig/D Il:l
( Tears LA Diag |Botdelline Obstruction
Description | Quality Control
Diagnasis | ;l Blow out longer (FET100% < 6 sec), chec
Notes ;I < | ﬂ

114 I Help

Patient Card

It collects all the information of a patient (first name, last name, date of birth) which
remain the same for each visit. For each patient there is only one Patient Card, which is
created the first time the Patient performs a test.

To move within the database use the following buttons:
Move to the first patient in the archive

Move to the previous patient in the archive
Move to the next patient in the archive

Move to the last patient in the archive

Find a patient in the archive

Enter a new patient in the archive

Delete current patient from the archive

B X P @ EEEE

Edit the current patient card

Visit Card

It collects all information relative to the visit (diagnosis, visit description...) and to the
patient information subject to change between one visit and another (height, weight,
smoke). Each patient can be related to several Visit Cards provided they have been
created in different days. Before carrying out any spirometric test it is necessary to
create a new Visit Card or to open the today’s Visit Card.

To move within the database use the following buttons:
Move to the first visit in the archive

Move to the previous visit in the archive

Move to the next visit in the archive

Move to the last visit in the archive

B EEEE

Find a visit in the archive
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Enter a new visit card in the archive
Delete current visit card from the archive
Edit the current visit card

Test Card

It contains all the information about the test.
To move within the database use the following buttons:

Delete current test from the archive.
Edit the current test

Import/export a Tests card

R =X =]

Diagnosis Database
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This function allows to import /export a test card with the respective visit and patient
card.

1. Select the patient.

2. Choose the test and press the key by side. All data will be imported/exported in the
XPO file format (Cosmed proprietary).

The program allows to manage a diagnosis database, whose records are composed by a
diagnosis ID code and a string of text.

The report of the visits can be done either by typing the desired text in the field
“Diagnosis” of the Visit Card or, more quickly, retrieving from the diagnosis database
the desired one.

If you want to insert, modify or delete a diagnosis from the database select Database
Diagnosis... from the File menu.




Spirometry program settings

The software allows to configure some options selecting Configure from the Option
menu.

Test options [ %]

Preferences | Spirometry I

[

Eureajbl E —Serial Port
cuven. 2 | -| | -,
Curve n_ 3: E = COM 2
Curve n_ 4: d
o 67 j i Unit of meas.
* Cm/Kg
v Grids ¥ Show InfoT est " Inch/Lbs
—User Free Fields
Patient Card | Visit Card | Test Card ‘
IU:el (Text) IU:e: (Text) IUser (Text)
IIJsel (Text) IUse: (Text) IUser [Numeric)
IUSEI [Text) IUSEI [(Text) IUser [Numeric)
ITI Cancel | Help |

Graphs

All the graphs visualised and/or printed can be customised in colours and appearance.

1. Select the desired colours of the curves (5 curves max can be overlapped on the
same graph).

2. Enable or disable the Grid option.

3. Enable or disable the Show Info Test option.

Serial port

You must select the serial port RS 232 that will be used to connect the Quark b* with the
PC.

To select the serial port, click on the proper COM button (the selected port must be
different from the mouse one).

Units of measurements

It is possible to configure the units of measurements, weight and height, for printing and
viewing.

To select the units of measurement click on em/Kg or in/lb according to the desired
format.

Using extra fields

The Patient’s database is organised in 3 different cards (Patient card, Visit Card and
Test card.) where it is possible to store the information about patients and visits .

Besides the standard information, it is possible to customise some fields (user free
fields), entering and labelling measurements coming from other devices.

The customisable free fields are:
e 3 fields in the Patient Card (Patient’s information)
e 3 fields in the Visit Card (information about the visits)

e 3 fields (2 numeric) in the Test card information about Test)

Customise the fields
In the group User free fields type the desired text in the 9 fields available.
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Exercise testing




Recommendations for the exercise testing

The evaluation of the cardiorespiratory function

The physical training requires the interaction of physiological mechanisms that allow
the cardiovascular and respiratory systems to supply the increasing demand of energy
due to the contraction of the muscles.

During the training the systems are both engaged, an adequate answer to the effort is the
measure of theirs health state.

The increase of the metabolic rate, during the exercise, needs an appropriate increase of
oxygen in the muscles. At the same time, the CO, muscles production must be removed

in order to avoid the lactic acid making.

To satisfy the increase in the gas exchange, necessary to the muscles during the
exercise, is requested the intervention of many physiological mechanisms. This process
involves lungs, the pulmonary circulation, the heart and the peripheral circulation.

Precautions

The physician has the responsibility that the patient subjects to the test is a suitable
person able to execute an effort test.

Laboratory

The room, in which the test is performed, must be big enough to contain the whole
necessary equipment, allowing an easier accessibility to the patient in case of
emergency.

In the room should be placed a thermometer and a hygrometer; the heart frequency and
the perceived values of the effort rise as much as the ambient temperature increases, and
the variability of the cardiovascular response grows for humidity values higher of 60%.
Generally it is considered 22°C the temperature adequate for the test execution, even for
short efforts, values till 26°C can be considered acceptable in presence of an efficient air
ventilation.

Ending the test

The patient should be monitored with ECG for at least 8§ minutes, in resting conditions
or until he returns to the pre-exercise conditions.

Preparing the patient

To enhance the value of a diagnostic test it’s very important patient collaboration. In
most cases a well-informed patient will make a better effort (in relation to his
conditions) and will allow a reliable interpretation of the test. For this reason every
ergometric test must be preceded from a precise training of the patient.

Before testing

The physician applying the exam must be provided with a written request including a
brief description of the diagnosis (confirmed or suspected ), the request’s reason and the
patient therapy carried out showing the dose and time of the drug assumption.

To standardise the response to the test and reduce the patient’s anxiety it’s suggested to
provide him either written (before the exam) or oral (at the same time of the test)
information. At the scheduling time detailed instructions should be delivered to the
patient, consisting in smoke and food abstinence three hours before an ergometric test,
or eight hours before a scintigraphic test.

Test are usually executed supporting the therapeutic outline in progress, but sometimes
it could be necessary to stop some drugs, such as b-block or calcium antagonist, which
could impair the effort response reducing the diagnostic accuracy of the exam.

The patient must wear comfortable suit and gymnastic shoes and two hours before test
stop any kind of drugs, eat light and avoid coffee and smoke.
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It’s very important acquire information on the patient’s clinical past before performing
the test. Keep attention in particular way to the use of drugs, tobacco, to the physical
fitness and symptoms produced with the exercise.

Patient assent

The patient is informed that he will be submitted to a maximum effort, which could be
stopped at any moment, and of the risks of the test execution.

Ending the test

Test may end when the maximum value of the oxygen consumption has been reached
and the patient’s response established.
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Real time test

Before starting exercise test type a new patient information or choose one from the list
of patient in the file. As soon as a patient has been entered the software is ready to start
a test. The name of the active patient is shown on the status bar of the program window.

Start a test

Start the test as described in the chapter Operating modes. If you use the device in
Holter mode, please skip this until Data management. The following is applicable only
to tests performed with the PC (telemetry or serial mode).

The software environment will change showing a new Menu bar and toolbar while the
first data will be displayed in a table format.

File Test Wiew Events ECG Window ? Demo

s%‘r& % fgészémpﬁ j; H;% %% ﬁf @} J :&zé Jx

-ERS
At this point the software starts showing data on the monitor but without saving them,
this in order to monitor the patient before starting the test. To start storing data press F2.

=

R

Abort the test without saving data
Choose Abort from the Test menu or press Alt+F3.

End the test saving data
1. Choose End from the Test menu or press F3.
2. Choose Yes to end the test or No to continue.

View data in real-time

Parameters to view
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The visualisation features and capabilities of the data and graphs are identical to the
ones described in the Data management chapter. Starting the test a small window will
appear on the right corner displaying time, bmp and, if selected before, the ergo
protocol and trainer.

T 140% ey

Q) 72 177
()00:01:38

View graphs in real-time
1. Choose Graph from the View menu.
2. Follow the instructions described in data management section to edit the graphs.

While the test is running, it is possible to choose the parameters to view.
1. Select Parameters to view/Test execution... from the Options menu.
2. Select the parameters and confirm.

Paramotors to view E

Select parameters to view

V|

X
CO2Zexp
VE/ND2
VENCO?
V02/K

Cancel |

FeD2
FeCD2 Restore |
HR
YO2/HR
Load1 hd 2 |




Manual protocol

E
AAA LORD

Tip: pressing the Shift key
while choosing the marker
option will allow you to enter
the label for that marker.

k4

Automatic protocol

FRO
=

Set the BPM alarm

If you are using the K4 b* with a treadmill without serial interface, it is possible to enter
manually from the PC the event, the phase and the marker.

Enter Load and Phase
1. During the test select Load from the Events menu.
2. Select the phase and/or type the value of the load and press OK to confirm.

Set the markers
Select Marker from the Events menu.

The software allows to automatically control the ergometer according to the protocol
previously selected. Anyway it is allowed to change it even after the test is started.

Modify the load during the test
1. During the test choose Ergometric protocol from the Events menu.
2. Select the row corresponding to the desired load and press OK to confirm.

The software allows the user to set the alarm level for the heart rate, in order to monitor
the patient response.

Enter the BPM

1. Choose BPM alarm from the Events menu.

2. Set the alarm by moving the scroll bar and press OK to confirm.

It also allows to enable or disable the acoustic alarm by the option "Acoustic alarm".
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Data management

Viewing data

AAA
Note: Double-click in the
window to open the edit test.

Creating graphs

GRAFH
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As soon as the test has been completed or downloaded, all data stored can be retrieved
for a complete management.

Data can be viewed in the following formats:

Table form numeric values of the various parameters (columns) corresponding to
each step (rows).

Graphic form  graphical presentation on Y1, Y2, X charts.
Summary results of the test and statistical analysis of the blocks.

Predicted predicted values, maximum value measured.

View data in table form
1. Select Data... from the View menu.
2. Select the test to visualise in the list box and press OK

Ml BOND J._ - testn. 2 S [=] 3

0z &)

t RE VT VE oz wCoz VE/WOZ | VE/WCOZ WOz /Ky R Feoz FeCOz HR VO2/HR  Load  Fet
hhimm:ss  himin 1 1/win  ml/min  ml/min -— -— mlimin/Kg -— % % bpw  ml/bprm  Wact %
0o0:00:00 12.2 1.151 14.1 556 505 25 27 7.32 0.80  15.86 4.35 61 9.1 o 14.
00:00:06 0.2 1.626 16.6 595 574 27 28 7.84 0.86 16.40 4.20 65 9.1 o 15.
0o:00:10 1z.7 0.610 7.7 250 236 31 3z 3.30 0.94 16.94 3.70 87 3.7 o 1s.
00:00:15 i3 .3 0.885 10.6 344 341 30 31 4.52 0.99 16.91 3.91 13 5.3 o 1s.
no:oo0:z1 0.8 1.043 11.3 403 372 28 30 5.30 0.92  16.¢62 4.01 13 6.1 o 1s.
00:00:z6 11.7 0.725 8.5 271 243 31 35 3.568 0.83 17.10 .48 66 4.1 oo 1s.
00:00:32 0.8 0.721 7.8 258 234 30 33 3.41 0.80  16.83 3.66 65 3.9 o 15.
00:00:37 11.3 0.805 S.1 288 270 31 33 3.80 0.83  17.12 3.62 65 4.4 o 1s5.
00:00:43 0.1 0.823 8.3 284 260 29 31 3.73 0.81 16.82 3.81 62 4.5 o 15.
00:00:48 11.5 0.769 8.8 285 260 30 33 3.75 0.91 17.05 3.59 63 4.5 o 1s.
00:00:54 9.4 0.796 7.4 249 zzk 30 33 3.27 0.90  16.98 3.87 63 3.9 o 1s.
0o:01:00 0.0 0.840 8.4 299 281 28 3z 3.94 0.387 18.73 3.77 63 4.7 o 1s.
00:01:07 9.1 0.722 6.5 237 203 27 3z F.11 0.86  16.65 3.78 63 3.7 oo 15,
00:01:14 8.9 0.721 6.4 234 199 27 3z 3.09 0.84 16.64 3.77 63 3.7 o 15.
oo:01:z20 0.0 0.728 7.2 263 227 27 32 3.46 0.86 16.63 3.80 64 4.1 o 14.
00:01:25 11.4 0.798 9.1 349 288 28 31 4.59 0.82 16.44 3.83 65 5.3 o 15.
0o:01:30 .5 0.947 10.0 376 ile 28 31 4.95 0.84 16.51 3.85 g6 5.7 o 1s.
00:01:36 0.8 0.888 = 339 294 28 3z 4.46 0.3 18.72 3.74 (13 5.3 o 1s.
0o:01:42 0.8 0.917 8.9 35z 309 28 3z 4.83 0.87 18.73 3.77 64 5.5 o 1s.
00:01:47 0.2 0.546 2.2 323 283 28 3z 4.25 0.87 18.77 3.74 64 5.0 oo 1s.
00:01:53 0.9 0.848 9.2 315 274 29 33 4.15 0.87 16.886 3.61 64 4.9 o 15.
0o0:01:58 0.7 0.881 S.4 328 292 28 32 4.32 0.89 16.78 3.77 64 5.1 o 1s5.
00:02:04 11.0 0.761 8.4 289 249 29 33 3.80 0.86 16.886 3.61 65 4.4 o 15.
oo:oz:o9 .5 0.817 8.6 286 261 30 33 3.77 0.91 16.95 3.69 64 4.4 o 1s.
00:02:15 11.2 0.876 9.8 3z0 283 30 34 4.z21 0.3 17.08 3.50 13 4.9 o 1s.
no:0z:zo 11.1 0.s07 0.1 337 zge 23 35 4.44 0.84 18.387 3.46 66 5o o 1s.
n0:0z2:zs5 0.2 0.735 8.6 275 z46 31 35 J.62 0.89 17.14 3.40 65 4.2 oo 15,
00:02:31 11.5 0.795 S.1 31z 269 29 34 4.10 0.86 16.89 3.57 65 4.8 o 15.
00:02:36 0.7 0.829 8.9 303 269 29 33 3.99 0.88 16.87 3.67 65 4.6 o 15.
00:02:42 0.9 0.736 8.0 269 234 30 34 3.54 0.86 16.98 3.53 64 4.2 o 15.
0o:0z:47 .7 0.821 8.8 299 260 29 34 3.94 0.86 16.89 3.59 65 4.6 o 1s.
00:02:52 11.3 0.875 9.9 335 297 29 33 4.41 0.3 16.91 3.85 (13 5ol o 1s.
ma.m 1A momen oo P Prey an 2 A nanone AmoAE o oEe | or an P

The software is provided with powerful functions for creating charts. You can add
custom graphs to create exactly what you need.

View data in graph form
1. Choose Graph... from the View menu.
2. Select the tests to visualise from the list and press OK

3. Choose the parameters you require on the X, Y1 and eventually for Y2; select if
necessary some of the following options by pressing the more button and press OK
to confirm.

It is possible to access quickly 5 common graphs from the View/Graph... dialog box.
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Note: Double-click in the graph
window to open the edit test

= V02, VC02/t - BOND J. -test n. 2

M=l E3

—*—V0Z (ml /min) VCOoZ({ml /min)——
‘

2855 ----d--=--F--=-q----om -~ P G - 3243

2648 P - 2004

za4z - g L 2758

2235 - . 2513

‘

2029 . L 2zes

1823 + 2023

1616 - Rk R - 1778

1410 - . 1533

‘

1203 . - 1288
297 - A L 1043
790 1 - 797
584 - - -2 - - scz

‘
277 i tihh:inm:ss)

00:30 01:57 03:24 04:51 06:12% 07:46 05:13 10:40 12:08 13:35 15:02 16:Z%

Right-clicking, the graph can be exported in bmp file format.

Customise the graphs

1. With a graph on the screen, choose Customise graph from the View menu.

2. On the Customise graph dialog box, select options to obtain the wished graph.

Customize Graphs E|

¥ Autoscale % (e |
From: 00:00:15 4 I bI
To- 00:14:45 1 I PI 2? |
— Ophtions ~v¥02 ~¥Co2
™ lgnore 0 % Grid
™ Points only
I Markers ¥ Autoscale ¥ Autoscale
[ Squared Min: [626.692 Min: [513.853
™ Mo recovery Max: |395IJ 29 Max: IAGISI,Bl
¥ Mark points Step: |u.uuuu Step: ID.EIDUIJ

Option Function

Grid on X, Y axes show the grid lines in correspondence with x or y axes that
make the graph easier for you to analyse data.

Autoscale maximum and minimum values of the graph will be measured
automatically.

Ignore 0 points with 0 value measured won't be shown.

Not interpolated
Marker

Squared

Without recovery
Mark points
Min. Max.

Step

make the graph scattered.

highlight with a symbol all steps of the test in which the marker
button was pressed.

makes the graph a square

exclude from the graph all points of the recovery phase.
marks each point with a symbol

allows to set manually the axes values.

Set the axes' scale step.

Switch from graph to data and vice versa

When the active window is a graph (or a report in data form), it is possible to view very
quickly the data (or the graph) corresponding to that test.

Choose Current test data (if the active window is a graph) or Current test graph...
(if the active window is a data report) from the View menu.
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Viewing predicted values

For some parameter it is possible to compare the maximum value measured during the
test with its predicted value and the LT value both in percentage and absolute.

View predicted values

@ . .
A Choose Predicted from the View menu.
HORMS
t(hh:imm:ss) ——— ——— 00:14:13 —
Load (Watt) -— 450 225
Real Load(Watt) ——— - —— ——
Revolution (RPN} ——— —— ——— —— ——
V02 Wass. (ml/min) - - 3534 2964 119.24
V02/Kg Wass. (ml/min/Kg) -—— -— 46.50 39.00 119.24
VE (1/min) -— -— 139.0 161.3 86.19
RE (b/min) — — 34.2 50.0 68.45
VT(1) —— —— 4.48 2.81 159.30
V02 /HR (1m1/bpm} ——— ——— 24.7 16.3
VE/VO2 [---) —— 57 ——
VE/VCOZ (---) — 35 _—
e - -
HRR (bpm) ——— 28 —
BR(%) ——— 2z.27 —
REE (keal/day) ——— —— - 1738.7 ———
VOZBLT (ral/min) ——— —— - 1274 ——
V02 Jones (ml/min) — — 3534 3059 115.54
V02/Kg Jones (ml/min/Kg) ——— — 46.50 40.25 115.54

Anaerobic (Lactate) Threshold detection

The software allows to detect the Lactate Threshold (Anaerobic Threshold) according to
the "Modified V-slope method" reference. The LT can be detected both manually and
automatically.

View the Lactate Threshold
— Choose Lactate Threshold from the View menu.
LY

Detect the Lactate Threshold
1. Choose Calculate LT from the Test menu.

2. For calculating it automatically on the "Lactate Threshold" dialog box click on the
Auto detect button.

3. For adjusting manually the point you want to detect, move the scroll bar on the
dialog box by pressing the arrow buttons. Data and graph of the LT will be
automatically redrawn.

4. Press Ok button to save your choices.

Lactate Threshold [ X]
* VC0Z (wl/min) = Fet02(%) FetC02(%) *
AAA 3991 H 18.00 - |-12.00
. . B H -
Note: Double-click in the 3582 H R T . [-16.20
. 3193 B 14_40 — 1. W - 14_40
window to open the : -
; N 2794 ' 12.60 |- 12.€0
corresponding dialog box. 2395 - : 10.30 4 ! | 10.80
19986 E 5.00 5 |- s.00
1596 H 7.20 e |-7.z0
1137 ' sano,, " e, .40
798 | ) 3.60 i |-2.60
' i
3394 - : 1.30 - ' |- 1.80
0 T T T T T VO0Z (ml/min) 0.00 T T T T VOZ (ml/min)
0 798 1596 2395 3193 3992 0 798 1596 2395 3193 3992
 VEAVOZ (-—-) VE/VCO2 (——-) + Parameter Values @LT Max % Max
53+ ; - 53 t (hh:mm:ss) 00:05:30 00:11:00 50.0%
45 - ' | 45 Load (Watt) 30 450 20.0%
el : | s Real Load (Watt) 0 0 00x
37 | . . Revolution (RPM) 0 (1] 0.02
| L] V02 (ml/min) 7 3032 401%
32 % . | b 32 ¥02/Kg (ml/min/Kg) 16.01 3990 40.1%
er b e, 27 VCO2 (ml/min) 1060 3991 265%
T A .1 VE (I/min) 247 130.7 18.9%
e : | e HR (bpm) 87 152 57.2%
10 ! o R () 0.87 168 51.6%
I
5 ' - s
0 T T T T T V0Z{ul/min) T4 |

0 798 1896 Z39E5 3133 39392

0K Cancel

Customise graphs for the LT viewing
The software allows to customise two of the three graphs for the LT visualisation.
1. Choose Lactate Threshold from the Options menu.

2. Choose the parameters you want to be shown on the LT window and press OK to
confirm your choices.
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Fittings

The purpose of the fitting function is to find the function that fits as better as possible
the measured data.

The software allows to fit data according to 3 different functions:

Model Function Algorithm Available for

Linear Y=A*X+B Least squares Any Y vs any X graph
Mono-Exp  Y=A+B¥*exp[(t-ty)/tau]  Levemberg Marquardt Any Y vs Time Graph
Mean value

This function is available only if the active window is a single Y graph (i.e. VO, vs time
or VO, vs Load).

s Fittings

Selection . E_| j|
X1 = |I]I]:I]I]:l]3 -] 4 Type: |
W Add

X2=IDDZ1E:15 I 0ok I Eancell 2 |

Fit a graph with a linear regression

1. Make active the graph window (any Y vs any X graph).
2. Right-click and select Fitting.

3. Choose Linear in the type combo box

4

Select the first point (X1) moving the mouse on the desired place in the graph
pressing the Left key or using the + and — keys.

5. Select the second point (X2) moving the mouse on the desired place in the graph
pressing the Right key or using the + and — keys.

6. Press OK to confirm.

Fit a graph with a Mono-exponential regression

Fittings E |
Inzert initial factors for the formula:
Y=B+A=[1-exp[ -t/Tau]]

A= Im [ Constraint
B = Il]'!:-I3 ¥ Constraint
Tau = |4l].l] [™ Constraint
Max. attempts: |1l]l]—

[ ok | cancel | z |

Make active the graph window (any Y vs any X graph).
Right-click and select Fitting.

Choose Mono-exponential in the type combo box

bl o

Select the first point (X1) moving the mouse on the desired place in the graph
pressing the Left key or using the + and — keys.

5. Select the second point (X2) moving the mouse on the desired place in the graph
pressing the Right key or using the + and — keys.

6. Enter (if necessary) the initial values of A, B and TAU (these are the values from
which the iterative algorithm starts in order to reach the best values; the closer are
the initial coefficients to the best ones the higher is the possibility to reach the best
fit).

7. Press OK to confirm.
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Oxygen Kinetic
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Calculate the "Mean Value"

1. Make active the graph window (any Y vs any X graph).

2. Right-click and select Fitting.

3. Choose Mean value in the type combo box

4. Select the first point (X1) moving the mouse on the desired place in the graph
pressing the Left key or using the + and — keys.

5. Select the second point (X2) moving the mouse on the desired place in the graph
pressing the Right key or using the + and — keys.

6. Press OK to confirm.

Note: The results of the O2 Fittings function are not stored therefore, in order to keep
the information, print the page using File/print Active Window.

This function is available only if the active window is a VO2 vs time graph and it has a
sense only with Constant Load Exercise Tests.

The aim of this function is to find the dynamic response of the rising and falling edges
of the VO2 together with the Oxygen Deficit and Oxygen Debt.

02 Kinetics I
Init. Fact. 02def Init. Fact. D2debt —— ~Selection [y
A1~ [e57 I C A2- [1657 ¢ | w=[00:0350 |- +| — |
Bl= 735 C B2= 2393 ~ec | e=[0omE0 o 4 Default |
- |4|1|] - |4|1|] —
Taul rc Tau2 rec Max. attempts: |'| oo X |

Run the O2 Kinetic function

1.

Make active a VO, vs Time graph window.

2. Press the right key of the mouse and select O2 Kinetic.

3. Select the beginning of the exercise phase (t1) moving the mouse on the desired
place in the graph pressing the Left key or using the + and - keys.

4. Select the beginning of the exercise phase (t2) moving the mouse on the desired
place in the graph pressing the Right key or using the + and - keys.

5. Enter (if necessary) the initial values for A, B and Tau (these are the values from

which the iterative algorithm starts in order to reach the best values; the closer are
the initial coefficients to the best ones the higher is the possibility to reach the best

fit) and press OK. You can lock data checking the relative field

=8 Y02/t - BRUGNDLS M. -test n_ 4

—*—V0Z {nl/min)
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VO2=452 114531 - expl (11781729 4];
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Information about the Test

&

Summary

AAA

Tip: double-clicking on the
Summary window the
function Options/Summary
is activated by which you
may configure the structure
of the data.

Print the data

The Test Information dialog box shows all the information concerning environmental
data, patient data and some data about the test

View the Information
Choose Information from the View menu.

Test information E
—Patient Calibration
ID code: 1TEST Temperatuie [*C): 22 STPD: 0802 |
Lazt name: BABETSIS Hl.lll'lidit_',' [X]: 61 BTPS insp: 1103 :
. . Temp. flow. ['C]: 34 BTPS exp: 1.020
First name:  GIORGOS Hum. flowm. (%): 100 Press. (mmHg): 740 |
—Patient data — Test
Ceax M FYC [“ 000 Date of test: 1370972002
Age: 34 FEV1 [I): 0.00 Time of test: 16:15
Height [cm): 182.0 IC (1): 0.00 UGHSLES e
Weight (Kg): 88.0 MYV (I{min): 0.0 LRl ReR2el
BSA [I'I'Iz]: 210 YO2?max [I'I'II]: o Duration [hh:mm:ss]: 00:16:15
HRmax (bpm): 186 User A: 0.00 LT time (hh:mm:ss): -
UN [g/day): 0.0 Uszer B: 0.00
¥D [ml): 6O Uszer C: 0.00
—MHotes
= Comments. .. |
Modify.. | LT |
|| calibration... 2 |

Modify the information
1. Press the Modify button on the Information dialog box.
2. Change the values you want to modify and press OK to confirm.

The software allows to assess the energy expenditure and metabolism substratum. In
order to measure FAT and CHO, type the UN (Ureic Nitrogen) value into the field. All
the nutritional parameter will be recalculate considering the UN value.

The summary feature allows to summarise test results according to the workload and
phase during the test.

View the summary
1. Choose Summary from the View menu.
2. The summary of the current test (active window) will be displayed.

§3 TREADMIL T. - test n. 3 (Summary) o [=] B3
RE VT VE voz vcoz  VE/VOZ VESWCOZ  VOZ/Kg R FeOz FeCcOz HR  VOZ/HR FetOZ FetCozZ
bfmin 1 L/win  ml/min  ml/min - - wl/min/Kg — —-- % % bpm  ml/bpm % &
Phase n. 1 Rest Start: 00:00:00 End: 00:01:03 gpeed: 0, Load2: 0, Load3: O
Hin 14.6 0.586 8.6 z1z 157 28 35 3.16 0.7% 16.51 z.49 88 z.z 15.08 4.12
Hax z1.0 0.971 20.3 619 489 39 sz 9.24 0.82 17.68 3.58 107 6.6 15.90 4.76
Lverage  16.8 0.747  12.7 343 272 33 43 5.2z ©0.77 17.23 2.95 54 3.6 15.60 4.29
Trend 19.8 0.853  16.9 54z 429 z8 36 §.05 ©0.73 16.65 3.47 108 5.1 15.21 4.85
Phase n. 2 Exercise Start: 00:01:10 End: 00:07:05 Speed: 4, LoadZ: 0, Load3: O
Hin 17.5  0.811  16.7 540 420 23 28 §.06 0.7z 15.75 3.54 110 4.7 14.34 4.37
Hax 51.5 2.883 138.1 3367 3978 45 36 50.25 1.32 17.99  4.37 196 18.7 17.20 5.36
Lverage  34.4 1.504 70.1 2074 2148 30 31 30.96  0.97 16.77 3.0 160 1z2.4 15.76 4.88
Trend 46.3  2.659 123.2 3158 3704 37 EH 47.13  1.17 17.50 3.80 187 16.6 16.80 4.71
Phase n. 3 Recovery Start: 00:07:07 End: 00:10:4% Speed: O, LoadZ: 0, Load3: O
Hin z5.2  1.170  34.0 477 834 33 28 7.13  1.16 16.95 3.02 130 3.3 16.08 3.82
Hax 43.2  2.795 118.0 3143 3647 74 41 46,5z  1.87 18.57 4.43 190 16.5 16.21 5.42
Lverage  34.6 1.880  66.3 1368 1510 51 35 z0.4z  1.45 18.11 3.57 156 5.3 17.41 4.45
Trend 30.6 1.268 38.8 770 966 47 37 11.50 1.25 18.10 3.25 132 5.6 17.50 4. 12
Lo |

It is possible to print graphs and data by means of two functions: Print report and
Print current window. The last one is active only if the active window is a graph or a
data report.
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View the report
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Print the current window

1. Be sure that the current active window is the graph or the report you desire to print.
2. Select Print current window from File menu.

3. Press OK to print, or Setup to customise the print.

Print the report

1. Select the report to be printed from File menu.

2. Press OK to print, or Setup to customise the print.

3. To only view the report, without printing it, press Shift during the selection.

This function allows to show a preview of a selected report.
1. Select Report from the View menu.

2. Select the test and the report to visualise and press OK to confirm.

Yizualizzazione Aeport - Elenco dei test in archivio

| 1D | Data | Durata | Home Elencu_

000001 20702797  00:14:13  BOND J. " Paziente attuale
000002 13703797  00:15:00  BOND J. £ Tutti i tast
000003 11704797  00-10:43  TREADMIL T. u

000004 14704797 00:0516  CARDIAC OUTPUT C.

000005 16704797  00-07-14  FA¥ LOOPS F. ~Report

000006  26/01/00  00:14:45  GAS + ECG 6. % Wasserman

" Constdplot

ST trends
" ERS 98
oK | Annulla |
Hote... |
Trova_.. | 2 |
——V0Z (ml /min) WCOZ (ml /min)——
3534 - 4095
Z8EZ [— =208
2189 — 2521
1E1&6 — — 1733
S44 — [— 9246
171 T T tihhmnm:ss)

00:00 0Ol:45 03:30 05:15 07:00 02:45 10:30 12:15 14:00 15:4°%




Data Editing

AAA

Nota: In Data view, double-
click in the window to enter
in “Data Editing”.

The software allows the user to edit the data acquired during the test in the following
ways:

e deleting one or more steps

e editing row data

e  input new parameters

e data filtering (averaging or smoothing)

e advanced data elaboration

After data elaboration it is always possible to restore the original data file by pressing
the Restore button .

If you want to save permanently all the changes, press Overwrite; being aware this
function replaces the original test definitely.

Editing values and input numerical values
1. Choose Edit test from the Test menu.

2. Select the cell containing the value you want to replace with others values and press
OK to confirm the editing.

The software will recompute all the parameters. Both the tables and the graphs will be
automatically updated.

Edit Test
—Phaze
Time | Ti Te v VT 02exp =
00:00:03 [(ER 235 | 069 . 0912 1544 || | C1- b
_________ i 512 = Warm-up
00:00:06 [ 1.40 222 | 083  1.133 & 192.0 3 - Exercise
00:00:11 | 139 249 0.90 1121 @ 1905 4~ Recovery
00:00:15 | 141 240 © 086 © 1.018 & 1728 I~ Marker: +10
00:00:19 | 1.40 © 254 . 087  1.020 & 1729 [
00:00:23 | 1.48 257 . 080  1.041 | 1763 0K
|oo:00:27 | 1.1 0 261 0 0.84 0 0935 @ 1590
__________________ e Cancel
00:00:30 | 1.44 243 0.82  0.919 | 1565 _
__________________ ol Preview
00:00:34 | 1.43 ' 246 © 0.84  0.947 @ 1616 —
__________________ B Filtering. ..
00:00:38 | 1.46 © 229 © 083 0960 & 1645 —_—
__________________ . o Delete step
00:00:41 | 1.40 | 225 | 0.80 © 0936 & 160.7 —
__________________ e Advanced...
00:00:45 | 1.44 | 225 | 078 | 0.95 & 1636 —
------------------ ' Hestore. __
00:00:49 | 139 | 227 | 0.7 | 0921 | 1574 | <] -
DOverwrite. ..
A 2 -
Testn. 21 Stepn. 14230 Duration: 00:16:15% - = |

Data filtering
Filter ?

(~ Discard invalid steps FILTER

= Averaging 00:24 <| | P| Ll

" Smoothing ot |3 Cancel
2 |

Choose Edit test from the Test menu.
2. Press the button Filtering and choose the option Discard invalid steps to
automatically eliminate all the invalid steps

3. Press the button Filtering and choose the option Averaging and type the desired
value for points Ave/smooth to perform an averaging of the all acquired steps. This
feature reduces the size of the original test.

4. Press the button Filtering, select the option Smoothing and type the desired value
for points. This feature doesn't reduce the size of the original test, although it
smoothes the fluctuation of data.
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Using the User fields

The software is provided with three free fields in which the user may enter values
coming from others devices such as lactate, blood pressure etc.

To define the user fields:
1. Choose User Fields from the Options menu

2. Type the desired text in the input fields and press OK.

To enter values in the user fields:

1. Choose Edit test from the Test menu.

2. Scroll horizontally until the fields USER 1, 2 and 3.
3. Enter the desired values and press OK to confirm.

Deleting steps

This feature is useful whenever some steps acquired during the test are to be discarded
(steps acquired before the start of the test, patient disconnected from the face mask....).

1. Choose Edit tests from the Test menu.
2. Position the cursor on the step you want to delete and press the button Delete step.

Advanced Editing

This feature allows to perform some advanced editing of the data stored in the software.
1. Choose Edit test from the Test menu.
2. Press the Advanced button and select from the following options:

Edit test - Advanced

— Mode
" Delete steps

¢ Smoothing

— Edit parameter

Parameter: |Ti

+ Value
" Comection %

" Dffset

" Formula...

Steps [smoothing]: |

%]
— Time Range
From: 00:00-02 <] &
E To: 00:05:16 <] &
v All steps
—Apply to
j J J & Value I
Rt . > [®
|_| £ Formula...
I v All steps
Save setlings... Load settings...
Apply Cancel 2

Option

Function

Delete steps
Smoothing
Edit parameter

Edit parameter

deletes the steps meeting the selection criteria
applies a moving average to the selected parameter
edits a parameter according to the selected criteria

Specifications

Value
Correction %

Offset
Formula...

Time range

replaces the value of the selected parameter with a new one.

applies a percentage correction to the value of the selected
parameter.

adds an offset to the value of the selected parameter.

replaces the value of the selected parameter with a
mathematical function.

Specifications

From, To
All steps

specifies the time range.
applies the editing from the beginning to the end of the test.




Apply to Specifications

Parameter specifies the reference parameter

>, >= = < <=, <> higher than, higher or equal, equal to, lower than, lower or
equal, different

Value/Formula... specifies the value (mathematical expression) compared
with the value of the specified parameter.

All steps do not use any selection criteria.

Restore the original test

To cancel all the editing, in the "Edit Test" dialog box press the Restore button, confirm
your choice by pressing yes.

Overwrite the original test

To save all the editing, replacing the original test with the modified one, in the "Edit
Test" dialog box press the Overwrite button, confirm your choice by pressing yes.

Customise the desktop

Smart edit

Customise the display colours

1. Select Colors from Options menu.

2. Select the item to be modified.

3. Press Change and select the desired colour.

This function is useful to correct data from artefacts; the noise affecting the measured
data can be reduced in 2 different ways:

Graphical noise suppression using the mouse

Threshold noise suppression applying a filter to the measured data
SmartEdit

SmartSmooth
Parameter: no corr. max coIr.

|Ti :” ﬂl:niselﬁ-]::3 iI_J ﬂ
"'-"Qll-lEII Luecutel Undo I Find I Fix |

Apply the graphical noise suppression

Cancel

-l

1. Make active a graph or a data window corresponding to the test that you want to
modify.

Press the right key of the mouse and select Smart Edit.
3. Select the parameter that you want to modify.

4. Point the mouse on the position where the graph presents the artefacts, click the
Right key and, keeping pressed the key, drag the point on the desired place.

5. Ifyou want to cancel the edit press the Left key of the mouse.
Repeat the above mentioned procedure for the all parameters and press OK.

Apply the threshold noise suppression

1. Make active a graph or data window corresponding to the test that you want to
modify.

2. Press the Right key of the mouse and select Smart Edit.
3. Select the parameter that you want to modify.

Set a Noise(%) Threshold (as a percentage of the parameter value) above which
any peak will be considered an artefact.

5. Press Execute and eventually Undo if you are not satisfied.
Press OK to confirm.
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Customise the parameters

The software allows the user to create customised parameters and predicted values,
derived from the standard parameters (the ones that are calculated by default) through
any mathematical formula.

All the customised parameters can be used freely for viewing and printing purposes.
Formula Editor v.1.4b
Parameters ml/min

gin | t:nsl tan | rad |

Pl |

degl e:upI Ign I LugI

Formula:

ahsl nk | sqrtl

[rvo2]

m | 0K I Cancel | Lalculator |

Create a new parameter

“102

wUEDz
UE :

AR

AN

2.

Choose Customise parameters from the Options menu.

Press the New button if you want to create a new parameter or Modify if you want
to modify an existing one

nn n.n

Type the desired value in the fields "Name", "unit of meas", "integers", "decimals"
and "summary" (to present the parameter in the summary) and press the Formula
button.

Insert the mathematical formula by using the appropriate tools and press OK twice
to confirm.

Create a new predicted parameter
1.
2.

Choose Customise predicted from the Options menu

Press the New button if you want to create a new parameter or Modify if you
intend to modify an existing one

non

Type the desired value in the fields "Name",

n.n

unit of meas", "integers", "decimals".
Select the group of the predicted values from the options boxes.
Select the reference parameter in the "Compared to" list box.

Press the buttons in the calculation group and insert the mathematical formulas for
men and women, adults and paediatrics. Press OK twice to confirm.

Once you create the new predicted you can see it in the predicted window.

Predicted values E3

Delete... | New.. | List.. | Find |
Copy... | Impoit.... |
Unit of meas.
I r Calculation

- Male, paediatiic

Integers: I
Decimals: I_

Males limit age: I

Females limit age: I

Related to:
=

[no parameter)

Male, adult

I
r Female. paediatric
I

Female, adult

DK I Export... |
Close | ? |
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Exporting data

N

AAA

Note: The DDE function is
available only if the user PC
has Microsoft Excel

installed.

With this function you can export the tests data and parameters in different file formats:

*.txt (ASCII)

*wkl1 (Lotus 123)

Export a test

1. Choose Export Tests from the Test menu.

* xIs (Microsoft Excel)

* xpo (Cosmed proprietary file format)

2. Select the test to export from the list box and press OK to confirm.

3. Select the file output format from the list box, click on *.xpo, *.txt, *.xls or *. wk1.
If you selected ASCII format, by clicking on Text button you can then select the
Thousands sep. and Column sep. according to the program you want to use. With
the xpo Cosmed format you can import/export the tests performed on another K4

b? equipment.

4. Select the folder, type the file name and press OK to confirm.

File name:
|lest#25. ®po

Folders:
c:\cosmedik4b2_en

Export test n.1 EE

Save file as type:

yeh

3 cosmed
£ k4b2_en
(2 drivers
[ test

Drives:

- _m

I[Znsmed formalt [*_xpo) J

I = c: hard disk ¢

j Text .. I

DDE with Excel

If Microsoft Excel is installed on your PC, you can export a test simply pressing a

button on the toolbar.

To send a test to Excel, select Send to Excel from the Test menu.

The program will show a status bar indicating the data transmission to Excel. At the end
of the process a new sheet with all test data will be opened ready to be edited with the
powerful functions of Microsoft Excel.
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Creating Test Protocols
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The software allows to create different exercise protocols to use during the test. The
load of the ergometer is automatically controlled by the software that change it
according to the defined protocol.

Create a new protocol
1. Choose Real Time > Ergom. Tests Protocols from the Options menu.
2. Press New and enter a name for the protocol.

3. In the field "Message Time" type a number that means to get a message to advise
when switching to the next load.

4. Enable the "Drive Ergometer" check box to let the software control the ergometer.
Select the "Initial Command" if the ergometer need it.

5. Enabling the option "Relative Increments", the loads refer to the previous step.

6. Press Generate and enter the values to generate a protocol from only one load (i.e.
30 Watt each minute for a total of 20 steps) and press OK to confirm.

Press Add if you want to add a new step.

8. To edit a step, select it from the list and change the relative values in the Edit boxes
below the list. Press the Tab button to save changes.

9. To delete a step, highlight the step and press Delete.

Ergometric Tosts Protocols
—Steps
N Ergometer: | COSMED Treadmill ﬂ t Speed Elevation Phase Command
00:00:02 0 0 0 1 [no one) X a
00:01:00 0 0 0 2 [no one)
_ 00:02-00 5 0 0 3 [no one)
Pratocaol 00:02:20 10 0 0 {no one)
Mame: |JERTELNGEL R ™ Hew._. | 00:02:40 15 0 0 [no one)
J 00:03:00 20 0 0 [no one) b
Message Time [sec.): |5 Delete... | ggggig gg g g E:z g::;
00:04:00 35 1] 1] [no one] b
I” Messages 00:04:20 40 0 0 [no one] i~
¥ Drive ergometer Generate... Edit... | Add... | Delete |

I” Relative Increments

Initial command: | (no one) j

Final command: | [no one] j 2 |




Software configuration

Data viewing

Steady State

The software can be customised as you wish. Most of the feature are easily editable to
be tailored according to different purposes.

The software allows to calculate a huge number of parameters; it is advisable, in order
to simplify the analysis of the results, view in the data window the only desired
parameters.

Select the parameters to view

1. Choose Parameters to view/Test visualisation... from the Options menu.
2. Select the parameters you require to view.

3. Press OK to confirm the selected configuration.

Select the parameters to view during the test

1. Choose Parameters to view/Test execution... from the Options menu.
2. Select the parameters you require to view.

3. Press OK to confirm the selected configuration.

Sort the parameters

It is possible to sort the parameters (both for viewing and printing purposes) according
to the desired order.

1. Select Sorting parameters from the Options menu.

2. Move the parameters in the order you want by pressing and holding the left mouse
button.

3. Press OK to maintain the current configuration.

The program has an algorithm to tag sets of steps as Steady State.

The algorithm considers belonging to the Steady State the only consecutive steps that
meet the following conditions:

e The value of VO2, VE and R do not vary from their mean values more than
Threshold (%);

e The number of consecutive steps that met the preceding criteria are at least
Minimum number of steps.

Steady State

Minimum n. of steps:

Y02 threshold [X]): Cancel

¥E threshold [%]: Reztore

B threshold [%]:

7
(iR

Customise the Steady State detection criteria
1. Choose Steady State from the Options menu

2. Type the desired values for Minimum number of steps, VO, threshold (%), VE
threshold (%) and R threshold.

The steps which satisfy these conditions will be highlighted with a yellow bar.
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Printout reports

The software allows the user to printout data and graphics according to 4 customisable
reports. Further it allows the user to customise a printout header that will be printed in
each page.
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Set up the printout

1.

Choose Reports from the Options menu.

2. Define the desired features of the report and confirm. Enabling the option "Graphs
in one page" all the graphs selected in the report will be printed in one page.
3. Type the name you want apply to the report and press OK to save changes.

. Beport n. Printed pages

L| ’76‘1 F2 3 (4 [~ Test data ¥ Predicted values
Name: IW’asselman ¥ Lactate threshold [~ Test summary

) Parameters... | [T Comments
¥ Graphs in one page
— Graphs

Print Y1 Axis Y2 Axis X Axis
MR [ve 2 (P ] o |
N2 [uR = [vozmr = | <] More._.|
N3 [vo2 =] [vcoz =] [x =] Mo |
NARW [y *] [tmogapn) =] [vco2 ~]  Moe... |
N5V [HR x| |vcoz =] |vo2 -] Moe...|
N6V [vEn2 = [vewcoz =] | -]  More_|
N.7 |v |VT j| |[no graph) jl |VE jl More... I
N8V [gm = [nogaph) =] [ ~]  Moe... |
N3V [pen2 ~| [Pecoz =] [t <] More..|
NA0T ] e Hl o graph) 7l e
N [ o [rovoon o [ o e
N2 [ o (oo o] [ =

| 0K I Cancel | Restore | 2 |

Select parameters to be printed

K4 b” allows to print a large number of parameters; it is advisable, in order to simplify
the analysis of the results, to printout desired parameters only.

1.

In the report configuration window select Parameters.

2. Select the parameters you require to be printed in the data printout. The number of
parameters which can be printed depends upon the size of the paper in use (see
Printer Layout) and from the orientation of the sheet.

3. Press OK to confirm the selected configuration.

Customise the printout header

1.

Choose Printout header from the Options menu.

2. On the "Report Header" dialog box type the text of the header.

3. To insert an image click the Logo button. An image editor will be opened, draw the
own logo and close the image editor to save changes.

4. Press OK to save the Printout header.




Electronic reports (*.pdf)

If an Adobe PDF writer “Printer Driver” is installed and set as the default printer, it is
possible to store the printout report automatically in any location of the HD or
eventually LAN paths according to a customizable filename format.

It is possible to define the created filename format selecting Options/Printout
header..., and then Name format...

Printed file name

Format:

Available fields
%b - date of birth | %i - ID |
%d - date of test | %1 - lagt name |
%F - first name | #n - test # |
%h - time of test | %5 - 8% |

OK I Cancel |

Print the current window

The print current window function is enabled when the active window is a graph or a
data report.

1. Select Print current window from File menu.
2. Press OK to print, or Setup to customise the print.

Print the customised report
This function is enabled only after having customised a report.
1. Select the customised report from File menu.
3. Set the sheet format and press OK.
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Flow Volume loops

2

02, CO2 vs Time
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Events management during exercise testing

By using K4 b’ in serial mode, beside standard measurements, the software allows also
to save some extra "events". They are so called "events" since they are not continuously
stored during the test but they can be saved upon user selection.

This test is useful during exercise to detect abnormalities in the mechanics of ventilation
in patients with pulmonary/ventilatory limitations to exercise.

The test consists in acquiring some flow/volume loops during exercise at different
workloads and overlapping them on the rest maximal flow/volume loop of a Forced
Vital Capacity test.

The majors information that you can get from this manoeuvres are the flow reserve
(flow distance from the peak flow of the F/V loop during exercise to the corresponding
flow on the superimposed F/V loop at rest) and the volume reserve (volume distance
from the maximum volume of the F/V loop during exercise to the corresponding
volume on the superimposed F/V loop at rest).

The manoeuvre consists in the following phases:
e Acquiring some Flow/Volume loops during the exercise

e Making the patient inspire completely up to TLC level (this is necessary to place
the loop correctly into the rest F\V loop of the forced Vital Capacity test)

e  Overlapping the F/V loop acquired during exercise and the F/V loop performed at
rest.

Flow Volume loop during the test
1. Start with normal Exercise test and begin the memorisation of breath values (F2)
2. During a steady state select F/V loops form Test/Event...

3. As soon as 2 or 3 complete loops have been acquired ask the patient to inspire
completely up to TLC level and press F3 to stop the acquisition.

The 02, CO2 event is useful to check the real-time readings of the O2 and CO2 signals
during the test.

02, CO2 vs Time during the test

1. Start with normal Exercise test and begin the memorisation of breath values (F2)

2. During a steady state select 02, CO2 vs Time from Test/Event...

3. As soon as 5 or 6 complete breaths have been acquired press F3 to stop the

acquisition.
54 pp. - Event: 02, CO2 Graph - (O] ]
— 02 (%) CoOZi%)—
25.00 I 1 1 1 1 I 1 I I 1
1 1 1 1 1 1 1 1 1 )
1 1 1 1 1 1 1 1 1 )
1 1 1 1 1 1 1 1 1 )
i b i | b | | ' —1z.00
___‘_I 1 I 1 1 —I I_I I_'__ _I )
Py Yy i [ v i !
20.00 - ; ‘—:\ :' | / R f ! f
I w r ) i Il Iu 1 "
1 I 1 i (Y | Y JI I\_______‘I‘I — 3. 00
i r o ’I vl [ ' =
1 M 1 - Fa 1 1 1 1 1 )
1 e | 1 1 1 1 1 1 1 )
1 1 1 1 1 1 1 1 1 )
A Rl
15.00 | Co | | b | | '
1 1 1 1 1 1 1 1 1 )
1 1 1 1 1 1 1 1 1 )
ﬂ 1 \ ! ' ! ' ' : —3.00
1 i 1 1 1 1 1 1 1 )
I 1 i 1 1 1 1 I )
1) 1 I} 1 0
10.00 T tihh:mm:ss)
00 0z 04 o6 05 10

t hh:mm:ss 00:00:53




O2 Saturation (optional)

Spirogram

The O, Saturation event is useful to check the quality of SpO, signal acquired by the on-
board Oxymeter (if available) during the test.

02 Saturation during the test
1. Start with normal Exercise test and begin the memorisation of breath values (F2).
2. Select O, Saturation from Test/Event...

3. As soon as 5 or 6 complete pulses have been acquired press F3 to stop the
acquisition.

The spirogram event allows to display and store the volume/time plot.

&8 F/¥ LODPS F. - Event: Spirogram
—vi1

-E T T T T T tihh:mn:ss)
ao0: 00 00:10 no:zo 00: 320 00:40 00:E0

t hh:mm:== 00:00:06

Spirogram during the test
1. Start with normal Exercise test and begin the memorisation of breath values (F2).
2. During a steady state select Spirogram form Test/Event...

3. Acquire volume/time plot until the window is filled and press F3 to stop the
acquisition.

View the events after the test

Raw data

1. Select Data... from the View menu

2. Select the test during which spirogram event has been carried out in the list box and
press OK

3. Select View... from the Events menu, choose the desired event and press OK.
4. Select Print Current Window... from the File menu to print the F/V curve page.
It is possible to edit the F/V loops event in the following way:

5. Select Edit... from the Event menu to change the F/V loop at rest (the list contains
all the FVC test carried out by the same Patient with the Spirometry software) and
press OK.

It is possible to edit the Cardiac Output event in the following way:

5. Select Edit... from the Event menu to change the parameters measured during the
steady state before the rebreathing, the CO, concentration at the equilibrium and the
calculation method.

It's a particular feature with which the user can check and save some parameters (CO,
output, O, concentration and volumes) in Ascii file format in a archive apart at a
sampling rate of 25 Hz.
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Save Raw data

1. During the test choose Event from Events menu.

2. Select Raw Data from the list.

3. On the save data box give a name to the file and select the destination folder.
4. To stop saving Raw data press the stop icon or press F3 on the keyboard.
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Resting Metabolic
Rate Test




Metabolism can be understood as the conversion by the human body between food and
accumulated fat into energy. The energy is used by the body to maintain constant
temperature , to move and to make all the organ function. Measure of metabolism is:
calories (cal).

Total Metabolic Rate

The total metabolic rate are the total calories that the human body needs in order to
actuate the daily functional activities.

Resting Metabolic Rate (RMR)

Resting Metabolic Rate represents the calories that the vital organs need to properly
operate at rest ( heart , brain , lungs , liver , kidneys etc.) . RMR represents between 60
% and 75 % of the human ‘s total metabolism.

Importance to measure RMR

A knowledge of the RMR is very helpful in order to understand the nutritional needs
and to properly manage it.

Measure of the rest metabolic rate with indirect calorimetry

Energy expenditure can be measured directly by putting a person in a calorimeter and
measuring the amount of heat produced by the body mass.

This is expensive and very impractical in the clinical setting. Energy expenditure can be
measured indirectly with a metabolic cart by analysis of respired gases (usually expired)
to derive volume of air passing through the lungs, the amount of oxygen extracted from
it (i.e., oxygen uptake VO,) and the amount of carbon dioxide, as a by-product of
metabolism, expelled to atmosphere (CO, output — VCO,). With these measurements
the resting energy expenditure (RMR) and respiratory quotient (RQ) can be calculated.

The RQ represents the ratio of carbon dioxide exhaled to the amount of oxygen
consumed by the individual. RQ is useful in interpreting the results of the RMR. The
abbreviated Weir equation is probably the most common calculation of RMR.

Abbreviated Weir equation:
RMR =[3.9 (VO2) + 1.1 (VCO2)] 1.44

How to perform a RMR test

For best results, when having a REE done, there are certain conditions that need to be
controlled and others that just require documenting at the time of the test. During the
test the individual is interfaced with a metabolic measurement system by means of a
facemask.

A mouthpiece with a nose clip is also sometimes used, but it may create overly stressful
conditions to a subject (patient).

Important considerations or conditions to improve the RMR measurement:
e No food for at least 12 hours and no smoke for at least 2 hours before the test.

e Maintain quiet surroundings when the test is in progress and normal temperature.
The individual should not move arms or legs during the test.

e  Medications taken should be noted, such as stimulants or depressants.
e The first 5 minutes of acquisition should be discarded by the computation of RMR

e Steady state should be achieved, which would be identified clinically by the
following criteria: 5 minute period when average minute VO, and VCO, changes
by less than 10%, average RQ changes by less than 5%

e Stable interpretable measurements should be obtained in a 15 to 20 minute test.

e Renal failure patients requiring hemodialysis should not be tested during dialysis
therapy.

96 - K4 b? User Manual




Recommendations

1. Since the ventilation is very low (normally <10 litres/min), the turbine calibration
has to be performed with very slow manoeuvres (each complete manoeuvre in
about 10-15 seconds), to obtain the best accuracy.

2. Use the following correction for the dead space (Vp):
- 50 ml for the small mask
- 60 ml for the medium mask
- 70 ml for the large mask
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Calibrations

Before the test, it is necessary to perform an ergo calibration (see Calibration chapter)
and it is advisable to perform also a turbine calibration (see Recommendations in this
chapter).

How to prepare a patient

The patient interfaces with the equipment by means of a face mask, like in the stress
exercise. The mask has to be tight to the face, in order to avoid any air leakage.

Start the test
1. Enter in the ergometry program
2. Select a patient or add a new one (File/Patients...)

= 3. Select Start test from Test menu
START

Modify test information
1D code: Iﬁmm =Dy
Last name: IBIJND
First name: [JAMES
Birth Date: [06/03/1957 SEK
Bl ate: & MEIE
Ethnic Cor. (%): [100  Female
Focute Tost E
e a0 Mode Height [cm): (178.0 Temperature ["C): |25
LT = L = £ Gas Weight (Kg): |76.0 Humidity (%): |5l:l
Weight [Kg): |76.0 EChE HR max (bpm]: [181 Press. (mmHg): [760
" Gas + ECG )
¢ Best ECG EEV1 (1): [0.00 Temp. flowm. [*C): |34
UN (g/day]): |0.0 Hum. flowm. (%) |1 00
[” Simulated test VD [ml): |0
i | test - cycl -
Ergometer: | [no one) j| | (1]4 I MNotes:
Protocol: | RMR j Wiy dkl.- | Distance: Illlll] Unit of meas.: I
Workspace: | RMR j Details.... | Load 1: |Load Unit of meas.: |w.,u 0K
Load 2: IReaI Load Unit of meas.: IWatt Cancel
C. | =
LI Load 3: IR"‘“ﬂ“t'“" Unit of meas.: I“PM 2

4. Enter the patient’s data and select the RMR mode (1st picture).

5. Press Other Data... and enter the dead space value (50ml Small mask, 60ml
Medium mask and 70ml Large mask). It is possible to enter the Ureic Nitrogen
value NU (2™ picture).

6. Confirm and start the test by pressing OK.
Selecting RMR the system set automatically the following options:
e Data acquisition with a 30 seconds average

e RMR protocol, which is:
- 5 minutes discarded,;
- 10 minutes with data acquisition, of which the software will make an average at
the end of the test;
- automatic end of the test after the 16™ minute.
e Selection of the RMR workspace (windows placement);
The test is fully automatic, the software will stop it and save the data at the end of the
16™ minute.

The real time view is as shown in the following picture:
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Viewing the test

AAA

Nota: The percentage of used
Proteins (PRO%) is calculated
assuming 12 grams of Ureic
Nitrogen in 24 hours. You can
modify this value selecting

View/Information... ->
Modify...

® PFT Ergo s @& 1 InfoCenter [_[5]-]
Fle Test View Events ECG Window ? Demo

228 FEAY X2k AR L

VO2,VC02t - BOND J, - test i, § [_ 1O %] VEHRA - BOND J, - test . 8 =] 3 Vo2

——7V0z (ul/min) WE0Z (ml/min)—— ——VE(1l/min} HE (bpm) —— gsg
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At the rend of the test, it will be opened automatically a window with the test results.
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At the end of the test, or if it is selected View/RMR, the main results are shown:
e The average time interval (default: 10 minutes)

e Average values of VO,, VCO,, R, RMR, RF, VE, HR, FAT% and CHO% and
predicted values if available.

Body Mass Index (BMI) and interpretation

e  Graph of the energetic expenditure for all the data acquisition interval, highlighting
the selected average interval.

In order to verify the goodness of the test, check that the ventilation and respiratory
frequency are similar to the predicted ones (12 breaths/min for the respiratory frequency
and 6 litres/min for the ventilation), and the heart rate is the rest heart rate of the patient.
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How to modify the average interval

Print
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If the average interval (automatically identified by the software) is not satisfying, for
example because the patient was speaking in the first minutes, it is possible to modify
the interval of the average.

Right-click and select Edit RMR.... It is possible to move the start and the end lines.
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To move the start line, left-click on the exact time in which you want to start the
calculations, for the end line, right-click.

The print of the current window generates a report similar to the one in the following

page.
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Sub-maximal
Exercise Testing




Introduction

Pre-test screening
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Several physiological responses to exercise are used to evaluate cardiorespiratory
fitness, including oxygen consumption, heart rate, and blood pressure. Measuring these
variables during exercise, particularly maximum exercise, increase the chance of
detecting any coronary artery disease or pulmonary disease.

Unfortunately, maximum exercise tests are impractical because they are expensive,
require extensive clinical supervision, and subject individuals to levels of physical stress
that may be unnecessary depending on the objectives of the test. Consequently,
maximal testing is reserved for clinical assessments, athletic evaluation, and research.

A sub-maximal exercise test costs less and carries a lower risk for the individual.
Although less sensitive and specific for detecting disease or estimating maximal oxygen
consumption, correctly performed sub-maximal tests can provide a valid estimate of
cardiorespiratory fitness.

Pre-test health screening is essential for risk stratification and for determining the type
of test that should be performed and the need for an exercise test prior to exercise
training. A thorough pretest health screening includes the following:

e Complete medical history

e Medical contraindications to exercise

e Symptoms suggesting cardiac or pulmonary disease

e Angina or other forms of discomfort at rest or during exercise
e  Unusual shortness of breath at rest or during exercise

e  Dizziness or light-headedness

e Orthopaedic complications that may prevent adequate effort or compromise the
validity of test results

e  Other unusual signs or symptoms that may preclude testing
e Risk factors for coronary heart disease

e History of major cardiorespiratory events

e  Current medications

e Activity patterns

e Nutritional habits

e Reading and signing an informed consent form




Sub-maximal exercise testing

Heart rate varies linearly with VO, to the point of maximum exertion; thus, VO,,,x may
be estimated using the relation between heart rate and VO, without subjecting the
individual to maximum levels of physical stress. During sub-maximal exercise testing,
predetermined workloads are used to elicit a steady state of exertion (plateau of heart
rate and VO,). The steady-state heart rate at each work level is displayed graphically
and extrapolated to the VO, at the age-predicted maximal heart rate (HR = 220-age). A
variety of protocols for different exercise modalities (i.e., treadmill, stationary cycle,
and step increments) can be used as long as the VO, requirements of each selected
workload can be estimated with accuracy.

The objectives of cardiorespiratory fitness assessments in the apparently healthy
population are as follows:

e Determine the level of cardiorespiratory fitness and establish fitness program goals
and objectives.

e Develop a safe, effective exercise prescription for the improvement of
cardiorespiratory fitness.

e Document improvements in cardiorespiratory fitness as a result of exercise training
or other interventions.

e Motivate individuals to initiate an exercise program or comply with an established
program.

e  Provide information concerning health status.

A few assumptions regarding testing are necessary to ensure the highest degree of
accuracy when using sub-maximal exercise testing to estimate VOyax:

e Selected workloads are reproducible. A steady-state heart rate is obtained during
each stage of the test. Usually, workload durations of 3 minutes or more are used to
ensure steady state.

e  The maximal heart rate for a given age is uniform (HR = 220-age).

e Heart rate and VO, have a linear relation over a wide range of values; thus, the
slope of HR/VO, regression can be extrapolated to an assumed maximum heart
rate.

e Mechanical efficiency (i.e., VO, at a given work rate) is consistent.

Although if done correctly, sub-maximal exercise tests provide valuable information
concerning cardiorespiratory fitness, they have extremely limited diagnostic capabilities
and should not be used as a replacement for clinical exercise tests or other clinical
treatment or management modalities. Health care professionals should avoid detailed
interpretation beyond the scope of the information obtained.

Considerations with sub-maximal exercise testing

Considerations for selection of protocol and equipment include any physical or clinical
limitations that may preclude certain types of exercise (i.e., age, weight, arthritis,
orthopaedic complications, individual comfort, level of fitness, type of exercise training
that will be performed, and individual preference).

For example, some individuals may perform better on a non-weight-bearing modality
(cycle versus treadmill), while others may not have the required range of motion in the
hip or knee to pedal and may perform better walking. Deconditioned, weak, or elderly
persons may have to start the test at a low work level and increase the workload in small
increments. Also, field tests may not be appropriate for those who require strict
supervision during testing, who do not understand the concept of pacing, or who cannot
be expected to put forth a good effort. More consistent results may be obtained by
testing in a controlled environment such as a laboratory setting. Creativity when
selecting protocols may allow adaptations of commonly used protocols to accommodate
athletes competing in specific sports. Regardless of the type of exercise and protocol
selected, the same type of exercise and protocol should be used for repeat testing if
between-test comparisons are important.
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Staffing

Test termination

106 - K4 b? User Manual

Staff members should be able to do the following:

Establish rapport with the subject and make him or her feel comfortable.
Recognize normal acute and chronic responses to exercise.

Recognize abnormal signs and symptoms during exercise.

Provide basic life support measures competently.

Adhere to established procedures and protocols.

S kW=

Clearly explain test results to the individual.

Sub-maximal tests should be terminated according to ACSM or other accepted
guidelines (see table in the following). In the event of an abnormal response, the test
should be terminated, the medical director of the facility and the individual’s primary
care physician notified, and all specified follow-up procedures performed. In the event
of mechanical or electrical failure that may compromise the accuracy of the test results
or monitoring capabilities, the test should be terminated until the problem is corrected.

General Indications for Stopping an Exercise Test in Apparently Healthy Adults

Onset of angina or angina-like symptoms

Significant drop (20 mmHg) in systolic blood pressure or a failure of the systolic blood
pressure to rise with an increase in exercise intensity

Excessive rise in blood pressure: systolic pressure >260 mmHg or diastolic pressure
>115 mmHg

Signs of poor perfusion: tight-headedness, confusion, ataxia, pallor, cyanosis, nausea, or
cold and clammy skin

Failure of heart rate to increase with increased exercise intensity
Noticeable change in heart thythm

Subject requests to stop

Physical or verbal manifestations of severe fatigue

Failure of the testing equipment

Assuming that testing is non-diagnostic and is being performed without direct physician
involvement or electrocardiographic monitoring.




Considerations for accuracy

The ability to obtain valid and reproducible results is essential to ensure that any
differences between pre-treatment and post-treatment test results are due to exercise
training rather than variations in testing procedures. Some inconsistencies that are
inherent may increase variability:

e Sub-maximal heart rate is influenced by time of day, eating, smoking, and
familiarization with test procedures.

e Prediction equations for estimating VO,..x may overestimate trained individuals
and underestimate untrained individuals.

e  The efficiency of motion during walking, running, and cycling varies.
e Cardiac output and VO, have a test-retest variability of 3-4%.

Psychological factors, such as pre-test anxiety, may influence the heart rate, especially
at rates below 120 beats per minute and at low workloads. It is not unusual for the heart
rate and/or blood pressure to be higher at rest than during the initial stages of exercise in
these cases. Having the subject repeat the first test may improve reliability, particularly
if the subject has never previously performed such a test.

Factors that can cause variation in the heart rate response to testing:
e Dehydration

e  Prolonged heavy exercise prior to testing

e Environmental conditions (e.g., heat, humidity, ventilation)

e Fever

e Use of alcohol, tobacco, or caffeine 2 to 3 hours prior to testing

Because of these inherent inconsistencies, standard procedures for each test must be
strictly followed to ensure the greatest accuracy and reproducibility possible:

e Standard testing protocol

e The same testing modality and protocol for repeat testing

e A constant pedal speed throughout cycle ergometry testing

e  Cycle seat height properly adjusted, recorded, and standard for each test
e The time of day for repeat testing consistent

e  All data collection procedures standardized and consistent

e Test conditions standard

e  Subjects free of infection and in normal sinus rhythm

e Prior to the test, no intense or prolonged exercise for 24 hours, smoking for 2-3
hours, caffeine for 3 hours, or heavy meal for 3 hours

e Room temperature 18-20°C (64-68°F) with air movement provided
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Performing the test

In this chapter it is supposed that the user is able to:

e perform an exercise test

e create exercise protocols

e view, edit and print tests

If this is not the case, please read the Exercise testing chapter.
To perform a sub-maximal test, follow these instructions:

1. Create a proper protocol (procedural guidelines for several sub-maximal testing
protocols are provided in [ACSM’s Guidelines for Exercise Testing and
Prescription, 6" Edition Philadelphia: Williams&Wilkins, 2000:22-29]).

Start an exercise test.

Perform the test as it were a maximal exercise test, ending it when the heart rate
reaches the 85% of the Hrmax, or it happens an event listed in the section Test
termination.

Display a VO,/Kg vs. HR plot
5. Right-click on the graph and select VO, submax from the pop-up menu.
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If the predicted HR max (calculated as 220-age) is not suitable for the patient tested, it
is possible to edit the HR max value from the View/Information... page.

An example of testing protocol
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An example of protocol is reported here. The YMCA cycle ergometry protocol is
defined as follows.

1* step: workload 150 kgm/min
2" step: if the HR at the end of the 1% step is: <80 80-89  90-100  >100

set the workload at (kgm/min) 750 600 450 300
3" step: if the HR at the end of the 2™ step is: <80 80-89  90-100 >100
set the workload at (kgm/min) 900 750 600 450

4™ step: if the HR at the end of the 3™ step is: <80 80-89  90-100  >100

set the workload at (kgm/min) 1050 900 750 600




Spiromeiry




Setting spirometry options

The software allows to configure some options selecting Configure from the Option
menu.

Spirometry
Test options x|
Preferences | Spiromety |

Automatic Interpretation i%_"

LLM Calculation: |j|

¥ Enable Automatic Interpretation

¥ Enable Quality Control

¥ Response graph in logarithmic scale
[~ Print active window FVC in ATS format [2 pages]

[" Reduce gcale on small curves

(114 I Cancel Help |

Avutomatic Interpretation

K4 b” has the function of interpreting each test performed by a patient visualising an
automatic diagnosis. The algorithm has been calculated basing on “Lung Function
Testing: selection of reference values and interpretative strategies, A.R.R.D. 144/
1991:1202-1218”.

The automatic diagnosis is calculated at the end of the FVC Test if:
e the automatic diagnosis option is enabled.

e the patient’s anthropometric data allow the calculation of the LLN (Lower Limit of
Normal range).

e atleast one FVC test has been performed.
To enable/disable the automatic diagnosis:

1. Click on Enable Automatic Interpretation checkbox to enable or disable the
calculation and the visualisation of the automatic interpretation.

2. Select the LLN (Lower Limit of Normal Range) criteria among the ATS
(LLN=Pred-0.674*SD), ERS (LLN=Pred-1.647*SD) or 80%Pred (LLN=Pred*0.8)
specifications.

Quality control

K4 b* allows a quality test control. The calculation has been carried out referring to
“Spirometry in the Lung Health Study: Methods and Quality Control, A.R.R.D. 1991;
143:1215-1223”. The messages concerning the quality control are shown at the end of
the test.

To enable/disable the quality control, click on Enable Quality Control checkbox.
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Parameters manager

Yiew | PFrint | Sort | Customize |
Mot selected parameters: Selected parameters:
Best FEVY1 : Best FYC Al @
D2575%pre Date
DFEY1%poss Date/time
DFEV1Zpre ERY
DFEV1%pred EVC
DFVCZpre FEF25-75% -
DPEF FET100%
DPEFZpre FEV1
IC FEV1/F¥C%
Te FEV1/VC%
Ti FRC
YEXT FRC/TLC
FVC =l

—All tests — F¥C Post

[ Show description [ Show % Pre

[~ Show 5D ¥ Show % Pred

| 0K I Cancel Apply | Help |

The program allows to calculate a huge number of parameters; it is advisable, in order
to simplify the analysis of the results, to view, to print and to sort the desired parameters
only. Select the menu item Options/Parameters...

View

Move the parameters to view into the Selected parameters list.
Print

Move the parameters to print into the Selected parameters list.
Sort

Drag the parameter up or down with the mouse.

Customise

Add, modify and delete custom parameters.

If it is necessary to restore the default parameters press the button in the left corner of
the window to initialise the parameters database.

Predicted values manager

Predicteds E

Predicteds set | Formula definition |

?,
>
HORMS

Desciription:

Name of the predicteds:

Set current predicteds

New
Save |
Age ITS
Male: Iﬂ Lopys~ | Mc Baicelona
Female: Il] Delpte |

™ Modify predicteds:

j Import... |
Export.. |

0K I Cancel | Apply | Help |

The program contains a preset of predicted equations, but the user is allowed to
customise its own predicted sets. Select Predicteds... from Options menu.

The window is divided into two forms: Predicteds set and Formula definition.

Predicteds set

This form allows the user to manage the set of predicteds. The following information
define a set:
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Name: identifies the set and cannot be duplicated;
Description:  free field;
Age: the adult predicteds start since this age.

To enter a new set of predicteds click on the New button. The field Name must be filled
and must be unique. To stop without saving click on the Cancel button. To save the set,
click on the Save button.

To delete a set of predicteds click on the Delete button. If a set is deleted, also the
associated formulae are deleted.

It is possible to generate a new set of predicteds with the same attributes and the same
formulae of the selected one. To do this click on the Copy... button and specify a new
Name.

To import a set of predicteds click on the Import... button and select a file of Predicteds
files type.

To export a set of predicteds click on the Export... button.
In the list Set current predicteds choose the current predicteds for printing and

viewing.
Set the current predicted

K4 b® allows to calculate the predicted values according to the following configurable
sets:

Adult Paediatric
ERS 93 Zapletal
Knudson83 Knudson83
ITS white ITS white

ITS black ITS black
LAM LAM

MC Barcellona MC Barcellona
Nhanes III Nhanes III

Select the desired choice in the group Predicted.

Formula definition

Predicteds set ‘ Formula definition |
@
Predicteds set: | £2 0NN - | mﬁs

Description:

{* lise the predicteds formulae: -ﬁ y
| = %

°)._or the customized formulaes

+ Hale

£ hemale Formula Standard Deviation

Young: I I
Adult: I I
ﬂl EI Palameter...l Save | Delete |

0K I Cancel | Apply | Help |

This form allows the user to manage the formulae associated to a set of predicteds.
Select the set of predicteds from the list Predicteds set.
To insert a new parameter click on the New... button.

The parameter formulae can be:




Page set-up

e calculated according to the predicteds in the list Use the predicteds formulae;

e customised by the user with the option ...or the customised formulae.

The Delete button deletes the selected parameter.

The Copy button stores the selected parameter in memory.

The Paste button inserts a new parameter from the one copied. If the name is not
unique, the user is asked whether to specify a new name or to replace the existing

parameter.

Page setup

Select Page Setup

Header

Data

Margins

Footer
Printed file name

... from the File menu.

All the printouts carried out by the program are preceded by 3
rows of customisable header (usually they contain the name
and the address of the Hospital using the spirometer).

Patient and visit information are printed below the header.
These data are reported on 3 columns and 5 rows. the user may
configure the disposition, change and eventually cancel the
fields, as he prefers.

Configures the print margins from the borders of the paper.
The unit of measure is decided in Units of measurements.

Configures information at the bottom of the page.

Defines the automatic name to be asssigned to the pdf file, if
the report will be printed in this format.

Page setup H

Header | Data | Margins I Footer | Printed file name |

Format:
|zdzlzl

Available fields

%b - date of birth | %i- 1D I
%d - date of test | %1 - last name I
%f - first name | %s - sex I

oK I Cancel | Help |

In the example it has been set to create a filename composed by
<date of the test> followed by <last name> and <first name>.
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Spirometry tests

AAA

Note: Read carefully the
contraindications in Chapter 1.
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Once completed the phases of the introduction of the patient’s data and the visit data, it
is possible to carry out the spirometric tests.

K4 b allows to perform the following tests:

Key Test

FVC pre Forced Vital Capacity

FVC post Forced Vital Capacity after bronchial stimulation
SVC Slow Vital Capacity

MVV Maximum Voluntary Ventilation

Before performing any test make sure that:

1. K4 b’ is properly connected to your PC and the selected serial port (COM1, COM2)
corresponds to the one effectively use.

2. The name shown on the status bar corresponds to the patient who is to carrying out
the tests.

3. The today’s visit card exists.




Forced Vital Capacity (pre)

FVC is a reference test to verify obstructive (airflow limitations) and restrictive
disorders (lung volume limitations). To achieve good test results it is fundamental a
good manoeuvre (quality control messages, real time plots ...)

Recommendations

The main parameters measured during FVC tests are:
FVvC Forced Vital Capacity
FEVI Forced Expiratory Volume in 1 second

FEV1/FVC%  FEVI1 as a percentage of FVC

PEF

Peak Expiratory Flow

FEF25-75% Forced mid-Expiratory Flow

The

two representative plots are the Flow/Volume and Volume/Time loops.

By comparing FVC, FEV1 and FEV1/FVC% values the software allows an automatic
interpretation concerning the levels of obstructive and/or restrictive disorders.

The flowmeter has to be disconnected from the breathing valve
The patient should wear the nose clips
The turbine has been recently calibrated (ATS recommends a daily calibration)

The paper mouthpiece or the antibacterial filter is properly connected to the
flowmeter through the corresponding adapter

For hygienic reasons, we strongly recommend the use of a bacterial filter.

Ifa

kid must perform the test it is recommended to enable the encouragement function

which shows exactly the manoeuvre of the FVC test.

Perform a FVC (pre) test

TEST

START

STOP

Test encouragement

1.

Select Forced Vital Capacity pre from the Test menu and wait for the green led is
prompted on the right side of the screen.

Explain the manoeuvre to the patient and press the F2 key.
Wait some seconds and perform the test.

After having performed the test, press F3 or wait for the automatic end (5 seconds
without flow), so that the software displays the F/V and V/t graphs, the main
parameters, and the predicteds values.

In order to visualise the F/V and V/t graph and the main parameters press the
following buttons:

. =
e view Flow Volume graph
Al view Volume Time graph

view data of the test
Press Alt+F3 to stop the acquisition discarding the results.
Repeat the test until it is correctly performed (ATS recommends 3 times).

Press Exit to visualise the test list carried out during current session together with
the results of the main parameters.

Select the test that you want to save (the Best Test according to the ATS criteria is
highlighted as default) and press OK.

During FVC manoeuvre you might experience some lack of collaboration with kids or
with other patients. In this case you may find a good help in using the encouragement
software tool.
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Perform the FVC test with the encouragement
1. Select Encouragement from View menu.
2. Perform the test as explained in the previous paragraph.

 Kit for Windows - [DINE IS - Real Time Test FVC] [_[51x]
B Iest View Window Help =181 x|
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Slow Vital Capacity

Important test for assessing COPD (chronic obstructive pulmonary disease) patients
affected by this disease might present a the Slow Vital Capacity could be higher than
the Forced one (FVC).

The main parameters measured during SVC tests are:

Perform a SVC test

TEST

T

2
@
STOP

AR
T

EVC Expiratory Slow Vital Capacity
IvC Inspiratory Slow Vital Capacity
ERV Expiratory Reserve Volume
IRV Inspiratory Reserve Volume

If the inspiratory/expiratory maximal manoeuvre is preceded by a some breaths at tidal
volume the software allows to measure the Respiratory Pattern, represented by the
following parameters:

VE Ventilation per minute

Vit Tidal volume

Rf Respiratory frequency

Ttot Breath time

Ti/Ttot Inspiratory time/Ttot

Vt/Ti Vt/Ti

1. Select Slow Vital Capacity from the Test menu and wait for the green led is
prompted on the right side of the screen.

2. Press F2 and instruct the Patient to breath normally until the message “carry out...”
is prompted; then ask to perform a Slow Vital Capacity (deep inhalation, maximal
slow expiration and deep inhalation again).

3. Press F3 or wait for automatic interruption (5 seconds without flow) in order to
visualise the V/t graph together with the main parameters compared to the predicted
values

4. To visualise the V/t graph and the main parameters press the follow buttons:

view Volume Time graph

view data of the test
Press Alt+F3 to stop the acquisition discarding the results.
Repeat the test until it is correctly performed (ATS recommends 3 times).

Press Exit to visualise the test list carried out during current session together with
the results of the main parameters.

Select the test that you want to save (the Best Test according to the ATS criteria is
highlighted by default) and press OK.

The reference for the ERV calculation is displayed on the V/T graph.
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Maximum Voluntary Ventilation

Perform a MVV test
w

TEST

[>

START

L)

STOP

HEORT

<]

EACE
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Test for assessing the maximum ventilatory capacity. In the past, it was commonly
performed during routine PF tests, however its clinical use declined over the years.
Today MVV test is most commonly performed as part of the exercise tolerance tests,
where it is used as an index of maximum ventilatory capacity. Test consists in breathing
in and out deeply and rapidly for 12, 15 seconds. The expired volume during this short
period is then extrapolated

The most important measured parameter is the following:
MVV Maximum Voluntary Ventilation

1. Select Maximum Voluntary Ventilation from the test menu and wait for the
green led is prompted on the right side of the screen.

2. Press F2 and make the Patient breath as much deeply and rapidly as possible for at
least 12 seconds.

3. Press F3 or wait for automatic interruption (5 seconds without flow) in order to
visualise the V/t graph together with the main parameters compared to the predicted
values

4. To visualise the V/t graph and the main parameters press the follow buttons:

view Volume Time graph

view data of the test
5. Press Alt+F3 to stop the acquisition discarding the results.
Repeat the test until it is correctly performed (ATS recommends 3 times).

7. Press Exit to visualise the test list carried out during current session together with
the results of the main parameters.

8. Select the test that you want to save (the Best Test according to the ATS criteria is
highlighted as default) and press OK.




Bronchial Provocation Test

Bronchodilator test

AAA

Note: Read carefully the
contraindications in Chapter 1.

Bronchodilators are administered routinely in the b* laboratory to determine whether
airflow obstruction is reversible. Bronchodilators increase airway calibre by relaxing
airway smooth muscle.

The test consists of comparing results between the reference FVC (FVC PRE) and the
FVC POST performed after the administration of the drug. Increasing value of 13-15%
of FEV 1, respect to the basal value (FVC Pre) is considered as a reversible condition.

Main parameters are the following:

DFEV1%pre Change of FEV1 as a percentage of test PRE
DFVC%pre Change of FVC as a percentage of test PRE
DPEF%pre Change of PEF as a percentage of test PRE

Some authors states that the above mentioned parameters are too dependent from the
FVC Pre, hence latest reference (ERS93, [A comparison of six different ways of
expressing the bronchodilating response in asthma and COPD; reproducibility and
dependence of pre bronchodilator FEV1: E. Dompeling, C.P. van Schayck et Al; ERJ
1992, 5, 975-981]) recommend the following parameters:

DFEV1%pred Change of FVC as a percentage of predicted value
DFEV1%poss  Change of FEV1 as a percentage of “possible value”

Methacholine and Histamine Bronchial provocation Tests

The most common indication for performing methacholine and histamine bronchial
challenges is to diagnose hyperresponsive airways. Some patients demonstrate normal
baseline pulmonary function despite complaints of “tightness” wheezing, cough, and a
little or not response to bronchodilator. Other patients demonstrate spirometric
improvement after use of bronchodilator have diurnal variation in peak flows. In this
groups aerosolised bronchial challenges are used to confirm a diagnosis of Asthma.

We can summarise the use of the test as follows:
1. Diagnose asthma

2. Confirm a diagnosis of asthma

3. Document the severity of hyperresponsivness
4. Follow changes in hyperresponsivness

When patients with hyperresponsive airways inhale certain pharmacologic agents (i.e.
Methacholine or histamine) the airways respond by constricting.

Test consists of executing repeated FVC following the pharmacologic agents inhalation
according to an established protocol. The fall of the FEV1 parameter is used to calculate
the bronchial hyperresponsivness. The most important parameter is the PD20 that is
amount of drug (mg/ml) that causes a reduction of 20% of the FEV1 respect the basal
value (without drug).

Main parameters are:

P10  Dose that causes a 10% fall of FEV1.
P15 Dose that causes a 15% fall of FEV1.
P20  Dose that causes a 20% fall of FEV1.

The representative plot is the Dose/response curve, showing the percentage variation of
FEV1 versus the Drug dose in logarithmic scale.

The program assumes as the baseline test the best FVC pre carried out during the
today’s visit. You can change the reference pre test editing the Post test.

The name of the drug, its quantity and its unit of measurement, can be typed
immediately before any FVC post manoeuvre (manual protocol) or can be stored in a
database of bronchoprovocation (File/Bronchial Provocation protocols Database...).
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Perform the test

(During 1st step only) select Protocol... from the Test menu and choose the name of the
bronchoprovocation protocol that you are going to use (manual protocol if you want to
type the information about the agent before any manoeuvre)

1. Select FVC post from the Test menu.

2. Select an existing protocol or click on “manual protocol”, and wait the green leds
turned on.

3. Press F2, or the button by side, to start the test.
4. Press F3, or the button by side, to achieve the test.

5. In order to visualise the V/t graph and the main parameters press the follow
buttons:

1=

FLIC

view Flow Volume graph

view data of the test

view bronchial provocation response
6. Press Alt+F3 to stop the acquisition discarding the results.
Repeat the test until it is correctly performed (ATS recommends 3 times).

Press Exit to visualise the test list carried out during current session together with
the results of the main parameters.

9. Select the test that you want to save (the Best Test according to the ATS criteria is
highlighted as default) and press OK.

Bronchial Provocation protocols Database
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The response to a bronchoprovocator is usually assessed in terms of change in the

FEV1, vital capacity or airways resistance on the basis of serial measurements (FVC

manoeuvres) in which the results of the initial test constitute the reference values. The

international literature proposes several standardised protocols in order to address the

methodological issues of the various available techniques.

The possibility to store a bronchoprovocation protocol in a database is useful to simplify

and automate the sequence of operations that the Physician need to execute during the

bronchoprovocation tests.

The typical sequence of activities to carry out a bronchoprovocation test are:

1. Typing and storing a bronchoprovocation protocol in the database (usually only
once).

2. Selection of protocol among the list of the ones already present in the database
before carrying out the FVC post tests (the selection of “manual protocol” allows to
execute the test fully manually).

3. Performing the Post tests.

Enter a new Bronchial provocation protocol in the archive
1. Select Bronchoprov. protocols database from the File menu.

2. Type the Protocol name, the Bronchoprovocator name and the unit of measurement
in the proper input fields.

3. If the bronchoprovocator has a cumulative effect select the cumulative check
button.

4. Enter the quantities for each step and press the button .




Viewing results

vl

All the visualisation functions refer to the test carried out by the Current Patient, whose
name is indicated on the left-side of the status bar.

To view tests results:
1. Select the Patients from the File menu
2. Select the patient corresponding to the test you want to view.

3. Select in the list box of the tests up to 5 tests of the kind (FVC, VC/IVC, or MVV)
and press OK.

To switch between graph and or data use the following buttons on the toolbar:

view Flow Volume graph (F5)

view Volume Time graph (F6)

view data of the test (F7)

view bronchial provocation response.

If you need more than one visualisation meantime use the New Window function from
the Window menu.

If you need to display a list of visits:
e  Select Visits list... from the File menu.

e  Type the name of the Company and/or the time interval desired or simply confirm
for the complete list.

Tests of the current patient

If a current patient has been selected you can quickly view his tests selecting Test
current patient... from the View menu.

Delete a test
1. Select Patients from the File menu or press the button by side.

2. Select the test that you want to eliminate from the list of the tests referred to the
Current Patient and press Delete.

Chapter 10 - Spirometry - 121




Printing results

Printing Reports

]

You can print out in three different ways:
e printing the Report
e printing the Active Window

e printing a series of reports

To print a report of the current visit, select Print report... from File menu. The
software will choose automatically the best performed test.

The standard Report is composed by 1, 2 or 3 pages depending if you wish to printout
the FVC data and the graphs together on the first page or if you wish to printout the
bronchoprovocation response.

e Selecting the option One page (no ATS) the report will contain, on one page, the
F/V and V/t graphs of the best test, overlapped on the FVC Post, the patient data,
the notes, the diagnosis and the test results.

e Otherwise the report will contain two pages, the first with the patient data, the
graphs and the diagnosis, and the second one with the measured parameters,
according to the ATS recommendations.

e  The 3" page will contain the bronchoprovocation response.

Select the desired options:

FVC graph Prints the F/V and V/t curves for the best FVC test.
One page (no ATS)  Prints data and graphs on the first page.

Response Prints the bronchoprovocator response.

Preview Views a report preview on the screen.

Printing the active window

This printout function is only enabled when the active window (title bar highlighted) is
one of the following objects:

e  Any kind of Graph.
e  Numeric data

e List of visit

To print the active window
1. Ensure that the active window is one of the preceding objects.
2. Select Print Active window from File menu.

Printing a series of reports

Sometimes it is useful to printout automatically a series of reports (all tests carried out
with the employees, all tests carried out in the today's session).

To print out proceed as follows:

1. Select Visit List from the File menu

2. Set the criteria of the visits to be added in the list (from, to,...)
3. Select Print Report from the File menu.

Electronic reports (*.pdf)
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If an Adobe PDF writer “Printer Driver” is installed and set as the default printer, it is
possible to store the printout report automatically in any location of the HD or
eventually LAN paths according to a customizable filename format.

It is possible to define the created filename format selecting File/Page Set up... (see
Page set-up).




Export data

With this function you can export the test data in 4 different formats:

*.txt (ASCII)

* xls (Microsoft Excel)
*wkl (Lotus 123)

* xpo (Cosmed)

Export a test

1.
2.
3.

Select Export tests from the File menu.
Select the test to export from the list box and press OK.

Type the name and the format of the file in the dialog Save as. If the ASCII format
is selected, the Text button in the dialog box Save as allows you to configure the
separators for character based files.

With the *.xpo Cosmed file format it is possible to import data from another K4 b’
archive. Press OK to confirm.

Select the folder for the export and type the file name. Press OK to confirm. A
status bar will show the file creation.
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Exiernal devices




GPS initialisation

The GPS operates on information gathered from satellites.To gather this information,
take your GPS on outside and find large, open area that has a clear view of the sky (a
nearby park would work fine). The GPS needs to receive at least three strong satellite
signals to find your location.

At the first power on the GPS needs to be initialized; the initialisation is a fundamental
procedure for obtaining accurate and reliable data and should be performed on a large
area where the sky is fully "visible".

After the initial self test is complete, the GPS will begin the process of satellite
acquisition and tracking. The acquisition process is fully automatic and, under normal
circumstances, will take approximately 45 seconds to achieve a position fix (15 seconds
if ephemeris data is known).

Like all GPS receivers, COSMED GPS utilizes initial data such as last stored position,
date and time as well as satellite orbital data to achieve maximum acquisition
performance. If significant inaccuracy exists in the initial data, or if the orbital data is
obsolete, it may take 5.0 minutes to achieve a navigation solution. The GPS
Autolocate™ feature is capable of automatically determining a navigation solution
without intervention from the user. This procedure may be required if one of the
following situations occurs:

1) Transportation over distances further than 1500 kilometers.
2) Failure of the internal memory battery without system standby power.
3) Stored date/time off by more than 30 minutes.

The GPS will automatically update satellite orbital data as it operates. The intelligence
of the GPS combined with its hardware capability allows these data to be collected and
stored without intervention from the host system.

Initialize the GPS

1) If the receiver is not operated for a period of six (6) months or more, the unit will
“search the sky” in order to collect satellite orbital information. This process is
fully automatic and, under normal circumstances, will take 3-4 minutes to achieve a
navigation solution.

2) If the memory backup battery of the GPS fails, the receiver will search the sky as
described above. Should the memory battery discharge, the unit needs to be
powered on for several hours to insure a sufficient recharge to maintain several
months of clock operation and memory storage.

3) If the initial data is significantly inaccurate, the receiver perform an operation
known as AutoLocate™ . This procedure is fully automatic and, under normal
circumstances, will require 1.5 minutes to calculate a navigation solution.

n

During the acquisition process a message "acquiring satellites....
display of the Portable unit.

is prompted on the

The AutoLocate™ function can be manually forced selecting GPS AutoLocate from
the Calibration menu, in order to obtain the best accuracy.

Fixing the antennato the subject
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The GPS Receiver has to be positioned onto the harness of the K4b” according the
following pictures, paying attention to keep the receiver in a position so that the sky will
be always "visible" during the test.

Some applications such as cycle racing and rowing may require different positioning of
the antenna.




Operating sequence

Test with GPS module can be carried out with K4 b* system in Holter Data Record or
Telemetry Data Transmission mode only. In addition to the Operating sequence of this
mode you must carry out the following operation.

Run a test with GPS
1. Connect the receiver antenna to the Portable Unit plugging phone jack into the

2. Select Settings then External device and press Enter.

3. Enable the GPS option by moving the “*”
settings.

4. Check the GPS module functionality choosing Calibration then GPS Control and

press Enter. Display will show latitude and longitude.

LAT: 41-°43.130
LONG: 12°36.701

5. With the use of Up and Down key verify that the displayed altitude value (Alt) is
different from zero. In case displayed altitude value is fixed on zero, please be sure
that the antenna receiver is well plugged in, the “sky” is visible and wait until the
Altitude value is shown.

VEL: 15.4
ALT : 670

sign on GPS and press Enter to confirm
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Monitoring GPS parameters in real time

To monitor in real time GPS parameters during Telemetry Mode Transmission or as
soon as test has been stored or downloaded, go to the PC software and select
Parameters to view/Test execution... (real time) or Parameters to view/Test
visualization... (after download) from the Options menu.

Select the following parameters:

Velocity GPS Vel (m/sec)

Distance GPS Dist (meters, incremented during exercise phases only)
Latitude Lat (DD°MM.MMM’ N/S)

Longitude Long (DD° MM.MMM’ E/W)

Altitude Alt (meters)

Only when test has been stored or downloaded you can verify the Graphical path
(automatically drawn on a scaled X/Y plane oriented to North ) selecting on the PC
software Visualization and GPS track.

Note: Distance is automatically calculated only during the "exercise"” phases.




Pulse Oximeter (option)

The oximeter option is useful to monitor SpO, value during the test. Test with this
option can be carried out with K4b” system in Holter Data Record or Telemetry Data
Transmission mode only.

In addition to the Operating sequence of this mode you must carry out the following
operation:

Operating Sequence

1. Connect the Oximeter module to the Portable Unit plugging phone jack into the
RS232 port at the bottom of the PU

2. Go to the K4b? control panel and select Oximeter like External device connected by
choosing Settings than External device and press Enter

oo

3. Enable the Oximeter option by moving the
to confirm settings.

sign on Oximeter and press Enter

4. Positioning Finger or Ear Clip on the patient and fix well the cable with Velcro
stripes on the harness to minimize motion artifact

To monitoring in real time SpO, value during Telemetry Mode Transmission or as soon
as test has been stored or downloaded, go to the PC software, select Parameters to
view/Test execution... (real time) or Parameters to view/Test visualization... (after
download) from the Options menu and select SpO, parameter.
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System maintenance

All service operations which are not specified in this user manual should be performed
by qualified personnel in accordance with the service handbook (to be required to the
manufacturer).

Rubber mouthpieces, face masks, breathing valve and the other parts are not shipped
sterile. They should be disinfected before using according to the following instructions.

All materials used in the construction of the K4 b are non toxic and pose no safety risk
to the patient or operator.

Prior to the device cleaning, disinfection and inspection it is necessary to switch off the
device and to disconnect adapters from the supply mains.

In order to guarantee the highest accuracy of measurements we recommend you to
disinfect the turbine periodically.

Cleaning and disinfection

AAA

Warning: Do not use
alcoholic solutions for the
turbine, otherwise there can
be damages to the plastic
material.
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Cleaning and disinfecting instructions are of fundamental importance to control
infections and assure patient safety. In fact aspiration of residue, particles and
contaminated agents are life — threatening.

In this handbook we strongly recommend you to follow the rules worked out by ATS
and ERS (see: ”Lung Volume Equipment and Infection Control” — ERS/ATS
WORKSHOP REPORT SERIES, European Respiratory Journal 1997; 10: 1928 —
1932), which are summarised and adapted for COSMED products as follows:

e Accessible internal as well as external surfaces of equipment exposed to expired
gas should be washed and disinfected prior to testing of subsequent patients.

e Disinfecting should ideally be performed by heat sterilisation, but gas or liquid
sterilisation can be used if the equipment is well cleaned first (no droplets of
saliva/sputum remain).

e Disposable gloves should be worn when handling mouthpieces, when cleaning
equipment exposed to saliva or sputum and especially when drawing blood.

e Laboratory staff should wash hands prior to testing of each patient.

e Adopt particular precautions when testing patients with recognised high — risk
communicable diseases (e.g. tuberculosis, multidrug — resistant staphylococcus). In
these cases, the clinical need for such testing should justify the risks.

During the disinfection:

e do not use alcohol or other liquids containing gluteraldehyde on the exterior
surfaces of the equipment. Actually they can damage polycarbonates plastics and
may produce unhealthy substances.

e do not use abrasive powders or glass cleaners containing alcohol or ammonia on the
plexiglas components of the equipment

e do not steam autoclave any parts of the equipment unless it is clearly specified.

e do not immerse the optoelectronic reader.

Cleaning the turbine flowmeter

It is necessary to disinfect periodically the turbine for sanitary measures or/and for the
correct device function.

As disinfecting solution it is suggested Sodium hypochlorite 5% (bleach).

The disinfecting procedure is easy and may be effected every time the user needs,
keeping attention to some precautions:




Turbine

Optoelectronic reader

Take out the turbine.
Dip it in a disinfectant solution (non alcoholic based) for about 1 hour.

3. Rinse the turbine in a vessel, filled of clean water, shaking gently to remove the
disinfectant (do not clean the turbine by putting it under running water!).

Let it dry to air.

5. After cleaning the turbine, check if the turbine propeller rotates freely even with a
low speed air flow.

6. Connect the turbine to the reader.

Precautions during the cleaning of the turbine
1. Do not expose the turbine to high heat and do not put it under running water.

2. Do not ever dip the optoelectronic reader in any kind of solution, the liquid
infiltration would damage the internal circuit.

3. Do not use alcoholic solutions to clean the turbine.

Suggested disinfection solutions
Helipur H Plus  Braun Melsungen AG
Gigasept FF Schulke & Mayr GmbH
Dismozon pur  Bode Chemie GmbH
TETA-S Fresenius AG

CIDEX Johnson & Johnson

Masks cleaning and disinfection

O

®
AAA

Warning: Do not use
synthetic or petroleum-
based products for the
masks cleaning.

The face masks should be cleaned and sterilised after each test.

Disassembling the different parts of the mask
1. Remove the valves from their place.
2. Remove the adapter for the optoelectronic reader.

Cleaning the mask
1. Clean the mask with hot water and a soap solution to remove the impurities.
2. Rinse the mask with energy in running hot water.

Disinfecting the mask
It’s possible disinfecting the mask following these procedures:

e Standard autoclaving method
Rapid cycles of autoclave lasting 10 minutes at 132°C (270°F)
Heavy cycles of autoclave lasting 30 minutes at 121°C (250°F)
Pre vacuum cycles of autoclave lasting 30 minutes at 121°C (250°F)
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e Hetilene oxide method (ETO)
The hetilene oxide doesn’t deteriorate the face masks. Sterilisation by this method
is not advised unless sufficient data is available regarding the time required for
complete out-gassing of residual ETO. If you use this method, follow carefully the
instruction provided by the maker of the sterilising product.

e Pasteurisation

The disinfecting with hot water is a sterilising method that may be used with the
silicone masks.

Permapure maintenance

Inspections

Replace the fuses
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e Do not bend, squash or deform it.
e Do not keep it in open air, if not used, especially in crowded or smoky places.
e Ifsaliva is entered in the tube, replace it immediately, because it lost its functions.

e Periodically grease the o-ring on the connector in order to simplify the flowmeter
connection.

e Replace it every 100 test / 6 month.

The equipment requires easy inspections to be carried out in order to assure a proper
electrical and mechanical safety level in the years.

These inspections are highly recommended after a rough use of the equipment or after a
period of storage in unfavourable environmental conditions.

Referring to the electrical safety, it is important to check the conditions of insulation
materials of cables, plugs and any other visible part by means of simple inspection,
when the equipment is switched off and adapters (or electrical feeders) are disconnected
from the supply mains.

Mechanical parts to check are: the turbine and breathing circuits.
Follow these instructions:
e extract the turbine from the optoelectronic reader;

e verify, by inspection, that the turbine axis fits correctly its seats and the blade is
strongly fastened on the axis itself (it can be useful to shake slightly the turbine in
order to note any anomalous movement).

Check if there are any torn or broken components in the breathing circuits: remember
that they can create safety risk to patients during tests.

The fuses can be replaced easily in the following way:
1. Open the power supply cover using a screwdriver as shown in the picture.

2. Extract the fuse holder as shown in the picture




3. Replace the damaged fuse(s).

Note: Be careful to use proper fuses:
A 680 023 500 (Time lag fuses 5x20 250V T500mA)
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Warranty and limitation of liability

COSMED provides a one (1) year limited warranty from the date of the original sale of
COSMED products. All COSMED products are guaranteed to be free from defect upon
shipment. COSMED’s liability for products covered by this warranty is limited
exclusively to replacement, repair, or issuance of a credit for the cost of a defective
product, at the sole discretion of COSMED. COSMED shall not be liable under the
foregoing warranty unless (i) COSMED is promptly notified in writing by Buyer upon
discovery of defect; (ii) the defective product is returned to COSMED, transportation
charges prepaid by Buyer, (iii) the defective product is received by COSMED no later
than four weeks after the last day of the one (1) year limited warranty period; and
(iv) COSMED’s examination of the defective product establishes, to COSMED’s
exclusive satisfaction, that such defect was not caused by misuse, neglect, improper
installation, unauthorised repair or alteration, or accident. If the product is
manufactured by a third-party, COSMED shall make available for the Buyer’s benefit
only those warranties which COSMED has received from the third-party
manufacturer(s). COSMED hereby specifically disclaims any and all warranties and/or
liabilities arising from defect(s) and/or damage(s) to and/or caused by products
manufactured by third-party manufacturers. Buyer must obtain written authorisation
from COSMED prior to the repair or alteration of COSMED products(s). Failure of
Buyer to obtain such written authorisation shall void this warranty.

COSMED hereby specifically disclaims any and all other warranties of any kind,
whether express or implied, in fact or by law, including, but without limitation, any and
all warranties of merchantability and/or fitness for a particular purpose.

COSMED shall not be liable for special, indirect and/or consequential damages, nor for
damages of any kind arising from the use of any COSMED’s products, whether said
products are used alone or in combination with other products or substances.

Determination of the suitability of any of COSMED’s product(s) furnished hereunder
for the use contemplated by Buyer is the sole risk and responsibility of Buyer, and
COSMED has no responsibility in connection therewith. Buyer assumes all risks and
liabilities for loss, damage or injury to persons or property of Buyer or others arising out
of the use or possession of COSMED’s products.

The limited warranty as herein above set forth shall not be enlarged, diminished,
modified or affected by, and no obligation or liability shall arise or grow out of, the
renderings of technical advice or service by COSMED, its agents or employees in
connection with Buyer’s order or use of the product(s) furnished hereunder.

Return goods policy for warranty or non warranty repair
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Goods shipped to COSMED for repair are subject to the following conditions:

1. Goods may only be returned after your receipt of a Service Return Number
(SRN) from COSMED S.r.1.

Place your SRN report and Packing List outside the package.

3. Goods returned must be shipped with freight and insurance charges prepaid.
Collect shipments will not be accepted.

4. The following list of goods are not eligible for return unless proven defective.
- Special order items
- Expendable products
- Goods held over 30 days from COSMED’s invoice date.

Used goods not in original shipping containers.

- Goods which have been altered or abused in any way.

5. The following parts are not covered by warranty:
- consumables
- fragile glass or plastic parts
- rechargeable batteries
- damages at the
- damages due to use of the device not conforming to the indication reported in this
manual




Repair Service Policy
Goods returned to seller for Non-Warranty repair will be subject to conditions 1, 2, 3, 4.

The returned goods need to re-enter COSMED together with the customs documents
(Pro-forma Invoice and Customs Paper) as requested by the Italian law.

e The shipment has to be qualified as a Temporary Export.

e All the goods returned to COSMED without the customs papers will not be
accepted.

For European Community members:
Pro-Forma invoice complete with:

e Number

e Description of the goods

e Quantity

e  Serial Number

e Valuein€

e Number of parcel

e  Gross weight

e Net weight

e Reason for resent (i.e. Resent for repair)

In case you should send the system for repair please contact the nearest service centre or
contact COSMED at the following address:

COSMED S.r.l.

Via dei Piani di Monte Savello 37
P.O. Box 3

00040 Pavona di Albano - Rome, Italy
tel.  +39(06) 9315492

fax  +39 (06) 9314580

E-mail: customersupport@cosmed.it

For USA customers only please contact:
COSMED USA Inc

1808 North Halsted Street
Chicago, IL 60614 USA
Phone: +1 (312) 642-7222
Fax: +1(312) 642 7212
email: usa.sales@cosmed.it

To ensure that you receive efficient technical assistance, please specify as precisely as
possible the nature of the problem as it is specified on the assistance information form.

We advise you to save the original packaging. You may need it in case to ship the unit
to a technical assistance centre.
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Privacy Information

Dear Customer,

we inform you that your personal data are gathered and will be used by Cosmed Srl in
conformity with the requirements of the Italian privacy law (Decreto Legislativo
196/2003). We believe it is important for you to know how we treat your personal data.

Personal data treatment and purposes
We request and process your personal data:

a.

to place an order, register a product, request a service, answer a survey, enter a
contest, correspond with us (all of the above, in the following: “service”) and, if
necessary, to supply the Competent Authorities with the required information;

in order to define your commercial profile;

in order to use your commercial profile for own marketing and advertising
purposes;
for accounting purposes, including e-mailing of commercial invoices;

for providing your information to selected business partners (also abroad), in order
to supply the service;

How your personal data are treated

Your personal data will be stored in electronic format, and protected at the best from
destruction, loss (even accidental), not authorized accesses, not allowed treatment or use
not in conformity with the purposes above listed.

The consent is optional, but...
If you deny the consent, we regret we cannot supply the service.

Holder of the treatment

The holder of the treatment is Cosmed Srl, Via dei Piani di Monte Savello 37, Pavona di
Albano Laziale (RM). The responsible of the personal data treatment is indicated in the
documentation stored by Cosmed Srl itself.

Customer rights
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In accordance with art.7 of the Law, you can:

a.

C.

obtain confirmation of the existence of your personal data and their communication
in intelligible form;

obtain:

¢ updating, correction or integration of your data;

e deletion or transformation in anonymous form of your personal data;
deny your consent to the treatment of your personal data;

These rights can be exercised directly requesting in writing to the holder of the
treatment.




Converting factors configuration

You can edit the parameters shown in Control Panel by selecting Control Panel from
the Calibration menu in the calibration program, then pressing the button by side.

Configuration parameters
0x0000 2] Raw data
0x0001 [CO2] ez
0x0002 [Ambient temp_] =
0x0003 [Internal temp.] qu
0x0005 [Barometric press.] . ; . P
0x0006 [Analyzers press.] Unit of meas.: Factor: Precision:
0x0007 [B attery voltage] Ix I-m

0x0009 [Heart rate]

0x000A [Turbine Flow]
0x000B [Turbine Volume]

v =

[mY - BL) = Gain £ 1000

Base line [m¥]: I-'.Z'Il
Gain exp: |1I]I]I]

Cancel

Gain ins: I-I 004

i

Help

You might configure the following options:
Name: identify the parameter

Unit of meas.: unit of measurement

Base line and Gain: factors used to convert the acquired raw data (mV) into the final
format according to Y=(mV-BL)*Gain. The value entered for
gain must be multiplied by 1000 (for Gain=1, enter 1000).

Precision:

the number of decimals shown as 0
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Calculations references

VO, and VCO,

"Energy Expenditure and Fuel Selection in Biological Systems: The Theory and
Practice of Calculations Based on Indirect Calorimetry and Tracer Methods": M. Elia,
G. Livesey, World Rev. Nutr. Diet. Basel, Karger, 1992, vol 70, pp 68-131.

"Nutritional Assessment in Critical Care, A Training Handbook": Donald C. Zavala

Anaerobic threshold (modified V-Slope)

0, kinetics
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The break-point or intercept of the two slopes can be selected by a computer program
that defines the VO2 above which VCO2 increases faster than V02, without
hyperventilation.

During an incremental exercise above the Lactate Threshold, the net increase in lactic
acid production results in an acceleration of the rate of increase in VCO2 relative to
VO2. When these variables are plotted against each other (squared graph without
recovery points), the relationship is composed of two apparently linear components, the
lower of which has a slope of slightly less than 1.0, whereas the upper component has a
slope steeper than 1.0. The intercept of these two slopes is the LT or AT point measured
by gas exchange.

The increase in VCO2 in excess of that derived from aerobic metabolism must be
generated from the buffering of lactic acid. This is an obligatory gas exchange
phenomenon seen in all subjects who exercise to work levels above their LT. This
technique is referred to as the V-Slope method.

OVS, Original V-Slope method: "A new method for detecting anaerobic threshold by
gas exchange", Beaver, Wasswrman, Whipp, JAP 1986, 60:2020-2027.

MVS, Modified V-Slope method: "Metabolic acidosis during exercise in patients with
chronic obstructive pulmonary disease", Sue, Wasserman, CHEST 1988, 94:931-938.

“Delayed Kinetics of VO2 in the Transition from prior Exercise. Evidence for O2
Transport Limitation of VO2 Kinetics: A Review”; R.L. Hughson and M.A. Morrissey,
Int. J. Sports Med. 4 (1983) 31-39

ISO 8996: Ergonomics — Determination of metabolic heat production, 1990
In the following picture it is shown how the O, debit and deficit values are computed.

¥=A+B*exp|-{-ta)Tau] 02 Kinetics VEAUE"exp[-(-1 HTau]
WOR@Erest=A+E VO2@rest=A
WO02@work=8 VO2@work=8'

25 to=start work t1=start work
t1=stap work t2=end test
02def=V02@mwork Tau 02debt=V02'@work'tau’

2 A7

02 deficit

wn

V02 (I/min)

VO2@work VO @work
02 debt

a5

-

VOI@rest e

[1} 50 to 100 180 tl 200 250 300

time eq)




ATS 94 recommendations

Reference: “Standardization of Spirometry: 1994 Update” “American J. Respiratory
Critical Care Medicine”, Vol. 152, 1107-1136; 1995.

ATS recommendations

Volume range: 81 (BTPS)

Flow range: +14 I/sec

Volume accuracy: +3% or < 50ml
Flow accuracy: +5% or < 200ml/sec

Flowmeter resistance: <1.5 cmH20O da 0 a 14 1/sec

Reproducibility: the 2 largest of 3 acceptable FEV1 and FVC values should be within
5% or 150 ml.

The end of test: no change in volume for 1 second with at least 6 seconds of collected
volume.

Accumulation time: the maximum time allowed for volume accumulation during the
VC manoeuvre should be at least 30 seconds and at least 15 seconds during the FVC.

The spirometer should be store at least 8 FVC maneuvres.

FEV1 should be calculated by using the “back extrapolation” method to detect the start
of the test, extrapolated volume must not be higher then 5% FVC or 150ml.

The graphic resolution of the printed report must be as in the following:
Volume: 10 mnv/1

Flow: 5 mm/l/sec

Time: 20 mm/sec

F/V ratio: 2:1

The total number of error (FVC e FEV1 >%3.5%, FEF25-75% >5.5%) during the
measurement of the 24 standard waveforms must be lower than 4.
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Predicted values

ERS93

KNUDSON 83

ITS (White race)

ITS (Black race)

LAM

Reference Adult:

Standardized Lung Function Testing: Official Statement of the European Respiratory
Society, The European Respiratory Journal Volume 6, Supplement 16, March 1993.

Reference Paediatric:

Compilation of reference values for lung function measurements in children: Ph. H.
Quanjer, J. Stocks, G.Polgar, M. Wise, J. Karlberg, G. Borsboom; ERJ 1989, 2,
Supp.4,184s-261s.

Reference Aduli/ Paediatric:

Changes in the Normal Maximal Expiratory Flow-Volume Curve with Growth and
Anging: J. Knudson, D. Lebowitz, J. Holdberg, B. Burrows; ARRD 1983; 127:725-734

Note: SD@FEVI1/FVC e FEV1/VC da ERS93

Reference Aduli/ Paediatric:

Intermountain Thoracic Society: Clinical Pulmonary Function Testing, second edition
(1984) pp 101, 144

Note: SD@FEV1/FVC e FEV1/VC da ERS93

Reference Aduli/ Paediatric:

Intermountain Thoracic Society: Clinical Pulmonary Function Testing, second edition
(1984) pp 101, 144

Note: SD@FEV1/FVC e FEV1/VC da ERS93

Reference Aduli/ Paediatric:

A survey of ventilatory capacity in Chinese subjects in Hong Kong: Lam Kwok-Kwong,
Pang Shing et Al. Annals of Human Biology, 1982, vol. 9, No. 5, 459-472.

Note: SD@FEV1/FVC e FEV1/VC da ERS93

Multicéntrico de Barcelona

NHANES I1I
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Reference Adult/ Paediatric:

Spirometric reference values from a Mediterranean population: J. Roca, J. Sanchis, A.
Agusti-Vidal, F. Segarra, D. Navajas. R. Rodriguez-Roisin, P. Casan, S. Sans. Bull. Eur.
Physiopathol. Respir. 1986, 22, 217-224.

Reference Adult/ Paediatric:

Spirometric reference values from a sample of the general US population: John L.
Hankinson, John. R. Odencrantz and Kathleen B. Fedan. Am J Respir Critr Care Med
1999, 159, 1798-187.




Automatic diagnosis (algorithm)

Reference: “Lung Function Testing: selection of reference values and interpretative

strategies”, A.R.R.D., 144/ 1991:1202-1218.
LLN=Pred-0.674*SD  (ATS, 50° percentile)
LLN=Pred-1.647*SD  (ERS, 95° percentile)

LLN=Pred*0.8 (80%Pred)
Message interpretation Criterion
Normal Spirometry FVC and FEV1/FVC > LLN

Obstructive abnormality (it may be physiological)
Obstructive abnormality: mild

Obstructive abnormality: moderate
Obstructive abnormality: moderately severe
Obstructive abnormality: severe
Obstructive abnormality: very severe
Restrictive abnormality: mild

Restrictive abnormality: moderate
Restrictive abnormality: moderately severe
Restrictive abnormality: severe

Restrictive abnormality: very severe

% Pred FEV1 >= 100

% Pred FEV1 < 100 and >= 70
% Pred FEV1 < 70 and >= 60
% Pred FEV1 < 60 and >= 50
% Pred FEV1 < 50 and >= 34
% Pred FEV1 < 34

FVC <LLN and % Pred FVC >=70
% Pred FVC <70 and >= 60
% Pred FVC < 60 and >= 50
% Pred FVC < 50 and >= 34
% Pred FVC <34

Quality Control Messages

Reference: Spirometry in the Lung Health Study: Methods and Quality Control, ARRD

1991; 143:1215-1223.

Message Criterion

Start faster VEXT >5% of the FVC and >150ml
Blast out harder PEFT >120 msec

Avoid coughing 50% drop in the flow in first second

Blow out longer
Blow out more air
Blow out harder
Take a deeper breath
Blow out faster

That was a good test
FVC reproducible
FEV1 reproducible
PEF reproducible
MVV time too short

FET100% <6 sec.

flow >0.21/s within 20 ml of FVC
dPEF<10%

dFVC<200ml and 5% best FVC
dFEV1<200ml and 5% FEV1
No errors

diff. 2 max FVC within 0.2 1

diff. 2 max FEV1 within 0.2 1
diff. 2 max PEF within 10 %
MVYV time less than 12 sec
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